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CAUTION:

TO PREVENT ELECTRIC SHOCK, MATCH WIDE BLADE OF
RISK OF ELECTRIC SHOCK PLUG TO WIDE SLOT, FULLY INSERT.
DO NOT OPEN
ATTENTION:

POUR EVITER LES CHOCS ELECTRIQUES, INTRODUIRE
CAUTION: TO REDUCE THE RISK OF ELECTRIC SHOCK, LA LAME LA PLUS LARGE DE LA EICHE DANS LA BORNE
DO NOT REMOVE COVER (OR BACK). CORRESPONDANTE DE LA PRISE ET POUSSER JUSQU'

NO USER - SERVICEABLE PARTS INSIDE. AU FOND.

REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

"WARNING"

"TO REDUCE THE RISK OF FIRE OR ELECTRIC SHOCK,
DO NOT EXPOSE THIS APPLIANCE TO RAIN OR
MOISTURE."

SAFETY INSTRUCTIONS

Read Instructions - All the safety and operating instructions
should be read before the appliance is operated.

2. Retain Instructions - The safety and operating instructions
should be retained for future reference.

3. Heed Warnings - All warnings on the appliance and in the
operating instructions should be adhered to.

4. Follow Instructions - All operating and use instructions should
be followed.

5. Water and Moisture - The appliance should not be used near
water - for example, near a bathtub, washbowl, kitchen sink,
laundry tub, in a wet basement, or near a swimming pool, and
the like.

6. Carts and Stands - The appliance should be used only with a
cart or stand that is recommended by the manufacturer.

10.

11.

12.

13.

14.

The lightning flash with arrowhead symbol, within an equilateral
triangle, is intended to alert the user to the presence of
uninsulated "dangerous voltage" within the product's enclosure
that may be of sufficient magnitude to constitute a risk of electric
shock to persons.

The exclamation point within an equilateral triangle is intended
to alert the user to the presence of important operating and
maintenance (servicing) instructions in the literature
accompanying the appliance.

Power Sources - The appliance should be connected to a power
supply only of the type described in the operating instructions or
as marked on the appliance.

Grounding or Polarization - The precautions that should be taken
so that the grounding or polarization means of an appliance is
not defeated.

Power Cord Protection - Power supply cords should be routed
so that they are not likely to be walked on or pinched by items
placed upon or against them, paying particular attention to cords
at plugs, convenience receptacles, and the point where they
exit from the appliance.

Cleaning - The appliance should be cleaned only as
recommended by the manufacturer.

Nonuse Periods - The power cord of the appliance should be
unplugged from the outlet when left unused for a long period of
time.

15. Object and Liquid Entry - Care should be taken so that objects

° do not fall and liquids are not spilled into the enclosure through
openings.

A 16. Damage Requiring Service - The appliance should be serviced

An appliance and cart combination should be moved with care.
Quick stops, excessive force, and uneven surfaces may cause
the appliance and cart combination to overturn.

7. Wall or Ceiling Mounting - The appliance should be mounted to
a wall or ceiling only as recommended by the manufacturer.

8. Ventilation - The appliance should be situated so that its location
or position dose not interfere with its proper ventilation.
For example, the appliance should not be situated on a bed,
sofa, rug, or similar surface that may block the ventilation
openings; or, placed in a built-in installation, such as a bookcase
or cabinet that may impede the flow of air through the ventilation
openings.

9. Heat- The appliance should be situated away from heat sources
such as radiators, heat registers, stoves, or other appliances
(including amplifiers) that produce heat.

17.

18.

19.

20.

by qualified service personnel when:
A. The power supply cord or the plug has been damaged; or
B. Obijects have fallen, or liquid has been spilled into the appliance; or
C. The appliance has been exposed to rain; or
D. The appliance does not appear to operate normally or

exhibits a marked change in performance; or
E. The appliance has been dropped, or the enclosure damaged.
Servicing - The user should not attempt to service the appliance
beyond that described in the operating instructions.
Al other servicing should be referred to qualified service
personnel.
The appliance should be situated away from drops of water or
spray of water.
Objects containing liquid such as vase must not be put on the
appliance.
The appliance is hot completely isolated from the power supply
even if the power switch is at off position.
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About this manual

Precautions

This manual covers all about how to use the Fostex FR-2 Field Memory Re-
corder.

Its explanations assume that you have basic knowledge and experience of
professional digital recording.

To understand the FR-2 features and learn how to use the FR-2 quickly and
roughly, we recommend reading "Chapter 1: Introduction" and "Chapter 3:
Names and Functions".

Chapter 2 ("Before using the FR-2) describes important basics about power
supply and memory cards. We recommend to read this chapter before using
the FR-2 first time.

. When supplying the power to the unit from the AC power outlet, only
use the Fostex Model AD12-1300 AC adaptor (note that the AD12-1300
is an option).

If you use any other AC adaptor, the unit may not work correctly and
there is a serious risk of damage to the unit.

. Make sure that the voltage of your AC power outlet matches the
voltage requirements printed on the AC adaptor.
If you wish to use the unit in a country where the voltage of the AC
power outlet does not match your AC adaptor, ask your local Fostex
dealer or service station for purchasing an appropriate AC adaptor.
Note that the AC adaptor can be used both in 50 Hz and 60 Hz areas.

. When operating the unit on batteries, use alkaline, Ni-Cd, or Ni-MH
batteries. Rechargeable batteries should be fully charged.

. When removing batteries or disconnecting the AC adaptor, make sure
that the unit [POWER] switch is set to "OFF".
Removing batteries or disconnecting the AC adaptor while the power is
"ON" may damage data because the unit always transfers data between
the current card and memory.

. While the unit is accessing a memory card (for example, during
recording), never turn off the power. Make sure that the unit
completely stops accessing the card before you turn off the power.
Otherwise, recorded data may be lost, as well as the memory card may
be damaged.

Note that Fostex assumes no responsibility on data loss or whatsoever
due to use of the unit.

. Fostex is not responsible for any "direct damage" or "indirect damage"
caused by using the unit.
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Do not let water or other liquid, or metal objects such as pins,
accidentally enter the inside of the unit (especially inside of the card
slots) because this may lead to electric shock or damage. Should water
enter the inside of the unit, turn off the power, unplug the AC adaptor
and remove batteries, and consult your dealer or the nearest FOSTEX
service station.

Do not drop the unit or give it a strong shock. The internal circuits,
display, panels may be damaged. Although the unit is designed to
operate outside, handle the unit with great care because it is a
precision machine.

To prevent possible electric shock and damage to the unit, do not
remove the cover or reach the inside of the unit.

When using the supplied carrying belt, to prevent the unit from
dropping accidentally, make sure that it is attached to the unit
correctly.

Do not give a strong shock to the LCD display. The liquid used inside
the LCD display is toxic. If the liquid is spilled, do not suck it in. If it is
stained to your hand or skin, wash immediately with plenty of water.

<Important> FOSL@X viopeL Fr-2
The model name, power requirement and | FIELD MEMORY RECORDER

. . FOSTEX CO.
serial number of the unit are labeled on ‘INPUT: 12vDC ===
SERIAL NO.
the bOttOl’l’l panel. TARTORDhIN=— MADE IN CHINA

Precautions on installation

Do not install the unit in the following conditions.

. in a extremely hot or cold place

. in a moist place

. in a shaky or unstable place

. in a dusty place

. in a strong magnetic field or near a device which generates a
magnetic field

. in the direct sunshine

. in the direct rain or water

Notes on moisture condensation

When you bring the unit from a cold place to a warm place, moisture
may condense on the drive, display, panels, etc. In such a case, leave
the unit for a while until it warms up and evaporates any moisture.
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Brief guide to this manual

This manual is intended to be used as a guidebook for using the Fostex FR-2
Field Memory Recorder.

The manual is divided into Chapters. Each Chapter covers instructions for a
specific subject or feature of the FR-2 which you should know for using the
unit, as well as safety instructions, precautions, etc. Please retain this manual
at hand so that you can read it whenever necessary.

<Manual organization>

The following shows a brief introduction of each chapter, though you may
know the contents of each chapter from the "Table of Contents".

Chapter 1: Product overviw
This chapter describes the brief introduction of the FR-2, as well as main
features.

Chapter 2: Before using the FR-2

This chapter describes some notes on the power supply, as well as memory
cards including the initial format.

Read this chapter before using the FR-2 for the first time.

Chapter 3: Names of Functions

This chapter describes names and functions of keys and controls on the
front and top panels, as well as those of connectors on the left and right side
panels.

If you are familiar with digital equipment, you may roughly understand the
FR-2 functions

by looking through this chapter.

Chapter 4: Basic connection

This chapter describes basic connection between the FR-2 and external de-
vices. It includes details about how to connect analog and digital audio sig-
nals, as well as how to connect a PC and a USB keyboard to the unit via USB
connectors.

Chapter 5: Recording/playback

This chapter describes analog and digital audio recording/playback using
the FR-2.

Descriptions for storing cue points, as well as the skip and locate functions,
are also included.
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Chapter 6: MENU mode

This chapter describes details about each menu items on each menu in the
MENU mode.

Five menus are available in the MENU mode. Each menu includes various
menu items as shown below. (Note that menu items may change when the
FR-2 is upgraded.)

1) Cue menu (including menu items regarding cue points)

Locate Used to locate to a desired cue point directly.
Rename Used to rename a cue point.

Edit Used to edit a cue point.

Delete Used to delete a cue point.

2) File menu (including menu items regarding audio files)

Select Used to select a file for playback.

Rename Used to rename a file.

Delete Used to delete a file.

Protect Used to select file protection on/off setting.
Restore Used to restore a deleted file.

3) Disk menu (including menu items regarding a memory card)

Select Used to select the current drive.

Optimize Used to optimize a memory card.

Format Used to format a memory card.

Volume Label Used to edit a volume label of a memory card.
Disk Info . Shows the current memory card information.

4) Setup menu (including menu items for FR-2 preferences, etc.)

File Name Mode Used to select the file name mode.

Default Scene Name Used to set the default scene name and take number for a file name.

Adjust Real Time Clock Used to adjust the real time clock.

Speaker Mute Used to select speaker mute function on/off setting.

Error Tone Used to set the error tone output condition.

Peak Hold Time Used to set the peak hold time of the level meters.

Pre Rec Time Used to set the time length of audio stored in the buffer when the
Pre rec mode is set to ON.

Remain Display Used to select the remaining display readout.

Digi Out Type Used to select the digital output signal format.

Battery Used to select the battery type.

Keyboard Used to select the USB keyboard type.

Version Shows the current ROM version.

Init Setup Used to initialize all Setup menu item settings to the default (when
the unit is shipped).

5) USB mode menu (enables PC connection for file transfer)

10 =
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Chapter 7: Exporting audio files to a PC

This chapter describes how to copy recorded audio file data (WAYV file) to a
PC hard disk and how to export data to a computer application software such
as the Digidesign Pro Tools.

Chapter 8: Specifications
This chapter describes mechanical and electrical specifications of the FR-2.

Manual conventions
This manual is described according to the following conventions.

1

5.

The following abbreviations are sometimes used.

<Examples>

CompactFlash card ->  CFC
Flash ATA Card > ATA
Sampling frequency > FS
Realtime clock ->  RTC
Personal computer ->  PC

The names of keys, switches and connectors of the FR-2 used in this manual
match their labels on the panel.

<Examples>

Playback key ->  the [PLAY] key

Sampling frequency select switch->  the [FS (kHz)] switch
Analog input connectors ->  the [ANALOG IN] connectors

The on-screen messages and switch position names are surrounded by " "

The on-screen messages and items, as well as the indicators on the panel,
"light" or "flash".

"Notes" give a tip or advice for using the FR-2 powerfully and skillfully.

\ 4
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Chapter 1: Product overview

This chapter describes the product overview as well as main features/functions, etc.

v
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Overview

Main features

14

The Model FR-2 is a portable two-track field memory recorder for profes-
sional use, which records to CompactFlash cards or Flash ATA cards. You can
make high quality recording either in stereo or mono.

Designed specifically for location recording, the FR-2 is a portable and light-
weighted machine, offering simple and easy-to-use operation. You can oper-
ate the FR-2 on batteries or on the optional AC adaptor.

The FR-2 provides two types of USB ports, allowing PC and USB keyboard
connection. By making PC connection, you can easily transfer audio files
from the FR-2 to a PC and edit the files on it.

. Two card slots are provided; one for TYPE II CompactFlash cards, the
other for Flash ATA cards. You can use either of these slots according
to the card used.

. Two ways to supply the power to the unit; batteries (alkaline, Ni-Cd, or
Ni-HM batteries) and the optional AC adaptor (Model AD12-1300).

. Supports the FAT3?2 file system. The Broadcast Wave File (BWF)
recording file format (interleave 1 file mode) is used, which enables
exporting files to a DAW such as Pro Tools.

. Supports a variety of sampling frequencies/quantization bits.
24-bit at 44.1 kHz, 48 kHz, 88.2 kHz, 96 kHz, 176.4 kHz and 192 kHz.
16-bit at 22.056 kHz, 44.1 kHz and 48 kHz.

. The "Pre Record" function, a useful feature for location recording,
enables FR-2 to constantly store up to approximately 20 seconds of
audio to the internal buffer. When you start recording, the previous
data is first delivered from the buffer (you can edit the time length of
audio stored in the buffer using the Setup menu in the MENU mode).

. Provides the input selector, trim control, high-pass filter and limiter
for each of left and right channels independently.

. 128 x 64 highly visible, low power consumption, backlit dot matrix
LCD display shows various information.

. USB port for PC connection. By connecting a PC directly, you can
transfer audio files (WAYV files) between the FR-2 and the PC.

. USB port for keyboard connection. By connecting a USB keyboard, you
can make some of setting or editing operations from the keyboard,
instead of operations using the FR-2 panel keys.

(Note that operations which you can make from a keyboard are
limited.)

. You can set a marker (cue point) at a desired point during recording
(up to 99 cue points can be set per file).
You can locate or skip to a desired cue point quickly.

J
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. The reference input level is fixed to -20 dB. The headroom margin of
the line input is +24 dB, while that of the mic input is +40 dB.

. By installing the optional TC/SYNC card (available soon), you can stripe
the IEC timecode.

. The error tone can be generated to warn you when the analog input
amplifier clips due to over level, when the battery voltage drops down
to the specific level, or when the remaining recording time of the
memory card gets short (you have to set the associated menu item
appropriately).

What is in the box

Make sure that the box contains the following. If any of them are missing,
please contact your Fostex dealer.

FR-2 1
Carring belt 1
Operation manual (this manual) 1

<Note>

No power supply (batteries or the AC adaptor) for operating the FR-2 is supplied.
To operate the unit on batteries, use alkaline, Ni-Cd, or Ni-MH batteries .

To operate the unit on AC adaptor, use the optional Fostex AC adaptor (Model
AD12-1300).

FR-2 options and related Fostex products

The following FR-2 options and related products are available.

Apply to your local Fostex dealer or sale office for further details (prices,
specifications, etc). you can also get information from the Fostex web site by
accessing to the following URL.

http://www.fostex.co.jp

Options
. External power supply unit (AC adaptor): AD12-1300

The following related products are also available from Fostex.

Related products

. DVD digital master recorder: DV40

. DVD location recorder: PD-6

. DAT digital master recorder: D-15

. Personal powered monitor: 6301B/BX

. Stereo headphones: T20RP MKII/T-5/T-7/T40RP MKII/T50RP

v
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Chapter 2: Before using the FR-2

<Please read this chapter before using.>

This chapter describes details about power supply for operating the unit and memory cards for
recording. Please read this chapter thoroughly before using the unit so that you can supply the
power to the unit properly, as well as make recording smoothly. Especially, never miss to read the
description of how to format a memory card.

<Table of contents>
ADOUL POWET SUPPIY ..ottt sneeteenne s 18
OpPerating ON DATLETIES .......cceeveereeeeereteeteteeteeteeteetesteseestestestessessessessessensensensansesensensensans 18
INSEITING DATLELIES ..eevueeereeeeereeteeeeiteereenteeeeeseeteeseesseeseesseesseesessesseessessasssasssessasnes 18
Reducing battery power CONSUMPLION ......ccceeeverververververeernessersessessersessessesseaens 19
Operating ON AC AAAPTOT ..cveeeveereeeeerreereeereecreesseeseeeseesseessessesssesssessssssesssassssesssssassssssesns 20
Connecting the AC AdAPLOL ......uevveeeeeereereerereereereersessessessessesseeseessessessessessessenses 20
TUINING ON ThE POWEL .....veecteeeereerteereeeeeeerteeeesseeeesseesseeseessessasssesssessessssssassssssassessesnses 20
ADOUL POWET SUPPLY VOILAZE ...oeveerererereteteeteteetetesteteteseessessessessessesessensessessessesenees 21
Setting the display backlight/CoONtrast ............cccverrireirineire e 22
Turning the backlight ON OF Off ........ccuevvevierrererrererrenererrerterrenrenresressessessessessessessessenses 22
Adjusting the diSPlay CONEIASE ....cueereereererrerrerrerrerrersereeseeseesessessessessesersersessessossessessesesses 22
About the realtimMe CIOCK .........c.ocieieee e 23
ADOULMEMONY CANTS ...ttt 24
Inserting/removing a MeMOTY CATA ....ccceveereereereereereereereeeeeeeeeeressessseeesesssessesesssessenes 24
Inserting @ MEMOTY CATd ......cceceeeeereerererereeeeeeseeeeeees e s eese s e e e e s eseeeasnnsneens 25
Removing @ MemOTY CATA .....ceveeeeeeeerereeeeeeeeeeeeeeessessesesesssssesssssssssssssessenns 27
Initial format Of & MEMONY CANd ..........cccoiiirieireeee e 28
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About power supply

The FR-2 is powered either by eight AA-type batteries (alkaline, Ni-HM or Ni-Cd) or by
the AC adaptor (Fostex Model AD12-1300, optional).
Ask your local Fostex dealer or sales office for purchasing the optional AC adaptor.

<Note>: Make sure that the FR-2 power switch is set to "OFF" when changing batteries or
when disconnect the AC adaptor from the unit. The unit continuously accesses data when
the power is on, so the memory contents may be reset by the sudden power interruption.

Operating on batteries

Batteries are not supplied with the FR-2, therefore, if you wish to operate the FR-2 on
batteries, purchase appropriate batteries.

<Notes on using batteries>

* Use alkaline, Ni-Cd, or Ni-HM batteries. Do not use manganese batteries.
Use new batteries (or fully charged batteries) when replacing batteries.
Do not mix old and new batteries together.

Use the same type of batteries in the FR-2 at one time.

Do not use leaked batteries.

% k%

<Notes on using rechargeable Ni-Cd/Ni-HM batteries>

* The FR-2 does not provide battery charging facility. To charge rechargeable Ni-Cd or
Ni-HM batteries, use an appropriate battery charger for the battery type and follow the
instructions of the charger to fully charge batteries.

* Inserting batteries

<Important! (Do not forget to make the following setting.)>

After inserting (or replacing) batteries and turning on the FR-2, be sure to select the battery
type (Ni-HM, Ni-Cd or Alkaline) to match the batteries inserted using the "Battery Type"
menu item on the Setup menu in the MENU mode. If the batteries in the battery compart-
ment do not match the battery type setting, the error tone function, etc. may not work
correctly because of the voltage difference.

See page 87 for details about how to set the battery type.

1) Remove the compartment cover on the bottom panel of the FR-2.
Use a coin, etc. to loosen the screw and remove the compartment cover.

fixing screw

18
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2)

3)

Insert eight AA-type batteries.
Make sure that the batteries are the right way round (+ and -), as shown below.

<Warning!>: Wipe terminals of the battery compartment and batteries with a dry cloth
on occasion. If terminals are dirty, the voltage supplied to the unit may drop down.

Fit the compartment cover as it was before.

Be sure to fasten the screw tightly so that the compartment cover never drops while using
the FR-2.

<Warning!>: Used batteries should be disposed following to your local regulations to
avoid problems of environmental pollution.

The chart below shows the expected battery life of continuous operation by type.
Note that it depends on the circumstance the FR-2 is used (temperature, humidity,
the number of recordings) and battery manufacturers, therefore, use the chart
just for your reference.

The FR-2 can indicate remaining battery life, as well as can generate the error tone
when the power voltage drops down to the specific level. When you use batteries
for operating the FR-2, you should also read "About power voltage" described on
page 21.

Ni-HM Alkaline
approx. 2 hours 30 minutes approx. 1 hours 20 minutes
(using 2300 mAh) (using 2300 mAh)

* Reducing the battery power consumption

For reducing battery power consumption to extend the battery life, when the
internal monitor speaker is disengaged (i.e. when a headphones plug is inserted to
the [PHONES] jack), no power is supplied to the internal amplifier which is used
for driving the internal speaker.

You can also reduce power consumption by the following tips.

. The lower the input impedance of a device connected to the FR-2's output
connectors, the less battery power the FR-2 consumes.

. The lower the output level of headphones or internal monitor speaker, the
less power consumption.

. If you do not use the FR-2 for a long period of time, you should remove
batteries (when batteries are inserted, the FR-2 consumes little power even
though the [POWER] switch is set to "OFF").

> 19
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Operating the FR-2 on the AC adaptor

To operate the FR-2 on an AC adaptor, use the optional Fostex AD12-1300 AC
adaptor.

<Notes>: Use only the AD12-1300 for an AC adaptor. Using another AC adaptor may
damage the FR-2 due to the mismatch of the power voltage, polarity, etc.
When connect or disconnect the AC adaptor, make sure that the [POWER] switch is set to

"OFF".

» Connecting the AC adaptor
While the [POWER] switch of the FR-2 is set to "OFF", connect the AC adaptor to the
[DC IN] jack on the left side panel of the FR-2, and then to the AC main outlet.

AC outlet= AD12-1300

<Note>: Do not unplug the AC adaptor while the FR-2 is accessing a memory card (i.e.
during recording, playback, etc.). By turning off the power, recorded or dacording data
may be lost, as well as the memory card may be damaged.

Turning on the power

By setting the [POWER] switch to "ON" after inserting batteries or connecting the
AC adaptor, the FR-2 starts up. If you turn on the power while no memory card is
inserted, the screen as shown below appears on the LCD display.

This screen is called “Home screen”. See “Home screen” on page 39 for details.

<Note>: The [POWER] switch is of the “momentary type”, therefore, when turning off the
power, you move it to the same direction as when turning on the power. To protect a
memory card and data, the FR-2 is designed to disable the [POWER] switch during re-
cording or playback so that you cannot turn off the power.

POWER

B ——[POWER] switch

fHDHemnruEans}
Femain= ——h—-—m

LL: H H H H HEEE N |
mEI 42 30 R 12 B4 a20dL
R H : : : I |
[T B R ————

When the FR-2 normally starts up, the "BATT" indicator at the lower right of the
screen (pointed by the arrow above) fully lights up. This indicates the sufficient
power is supplied to the unit.

20
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While operating the FR-2 on the AC adaptor, the indicator always fully lights up.
While operating the FR-2 on batteries, the length of the "BATT" indicator changes
according to the battery condition (the lower battery power voltage, the shorter
"BATT" indicator). Pay attention to the indicator when you operate the FR-2 on
batteries, and replace batteries at the appropriate timing.

See the next page for details about power voltage.

You can turn on the backlight of the display, as well as adjusting the display con-
trast. See "Setting the display backlight/contrast" on page 22 for details.

About power supply voltage

When the FR-2 operates on batteries, you can check the battery condition via the
"BATT" indicator.

When the battery voltage gets lower, the lighting area of the "BATT" indicator
becomes shorter. The battery life depends on batteries, however, you can roughly
know the current battery condition via the indicator (when operating the unit on
the AC adaptor, the indicator always fully lights).

“=m :| Battery capacity is sufficient.
: HEHEEH |
I2 E I'| E u L qj| Battery capacity is almost half.
_El qj| You should replace batteries.

<Note>: If you continue to use the FR-2 after the "BATT" indi- Warning — .,
cator gets shorter and batteries are exhausted, the display shows
the warning message as shown right, and the FR-2 automati-
cally shuts down. When operating the FR-2Z on batteries, you
should always pay attention to the battery power condition.

Batiery EmFidl

In addition to the "BATT" indicator, the FR-2 provides the error tone function
which warns you when the battery power drops down.

This function generates the error tone from the internal monitor speaker (or from
headphone output) when the battery power voltage drops down to the specific
level. You can make the error tone output setting from the "Errot Tone" menu
item on the "Setup" menu in the "MENU mode". See "Setting error tone output
condition" on page 87.

<Notes>
» Supplying excessive voltage may damage the unit. Never supply voltage which
exceeds the regular voltage.

» If batteries are completely exhausted or the power supply section has a trouble by
surge current, etc., the protection circuit works and the power is shut off. In such a
case, set the [POWER] switch to "OFF", replace batteries with new (or fully-charged)
ones, then set the [POWER] switch to "ON" again.

If the FR-2 does not return to the normal condition after carrying out the procedure
above, there may be some trouble inside the circuit. In such a case, consult your local
Fostex dealer or service station.

e Never turns off the power when the [ACCESS] indicator flashes. Data currently being
recorded or played back may be damaged.
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Setting the display backlight/contrast

According to the situation, you can turn the display backlight on or off, as well as adjust
the display contrast.

Turning the backlight on or off

By pressing the [LIGHT] key on the front panel, the display backlight turns on for
three seconds and then automatically turns off.

By pressing and holding the [LIGHT] key for more than two second, the backlight
turns on and keeps lighting. To turn off the backlight, press the [LIGHT] key again.

[SHIFT] key

[RIGHT] key

<Note>: When operating the unit on batteries, to save the battery power, we recom-
mend not keeping the backlight lighting unless it is necessary.

Adjusting the display contrast

While the unit is stopped, you can adjust the display contrast by following the
procedure below.

1) When the FR-2 is stopped, press the [LIGHT] key while holding down the [SHIFT] key.
The current contrast value is shown at the position where the current file name is
usually shown (pointed by the arrow below).

8,00,88./m

— Contrast = 31 | HEK |
Fush EHTEE EkKe4!
LL: : : H H HEHE I |
WED_ 42 30 F 12 B 4 @ 0oL

F T T H H H HEF N | .|

IEEFTAEE - —
2) Rotate the [MENU] dial to adjust the display contrast (adjustable level: 0 to 63).
Rotating the [MENU] dial changes the contrast in realtime.
The lower the contrast value, the lower the contrast is.
The higher the value, the higher the contrast is.

3) Press the [ENTER] key to fix the contrast value.
The display returns to show the previous Home screen, while the selected contrast
value is stored to the Flash ROM. If you do not press the [ENTER] key for five seconds
after adjusting the contrast, the display returns to show the Home screen and the
contrast value is stored automatically.

22
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Setting the realtime clock

The FR-2 offers the realtime clock and the time data is shown on the display .
Realtime clock data itself can be used as a file name when a new audio file is created on

the card (i.e. the file name shows the creation date/time of the file).

LL_ : H HEE N |
I:EIIIII“IZI “E Hu Ezl 2 B "! E 0oL
| H H | I

Realtime clock data——= [TENGITA I]H [IH E]

<Notes>: By default, the realtime clock is adjusted to the local time of the factory when
shipped. Therefore, set the time to your local time before using the unit.

"

You can adjust the realtime clock from the "Adjust Real Time Clock" menu item on the "Setup
menu in the MENU mode. See "Adjusting the real time clock" on page 85 for details.

<Notes>: By default, when an audio file is created, the realtime clock data is automatically
used as the file name (we call it "default file name"). The file name is shown on the display as
in the example below (pointed by the arrow).
You can select the default file name between "realtime clock data" and "scene name + take
number" from the "File Name Mode" menu item on the "Setup" menu in the MENU mode.
Also, when the "scene name + take number" option is selected in this menu item, you can set
the desired scene name and take number using the "Default File Name" menu item on the

"Setup" menu in the MENU mode.

I‘IBEHIEE- n

File name—» E 12h2dm2Rs 1941 2
Enmam—’-ﬂmzds mﬂ
Rc’:su '-IE auE-E| Eﬁélﬁl

L]
EI

* See "Selecting default file name type" and "Setting the default scene name" on pages 81 and
82.

<Note>: The FR-2 is equipped with a lithium battery which operates the realtime clock.
Normally, the battery life is approximately four or five years. When battery voltage drops
down to the specific level, the following warning message appears (the warning message can

be dismissed by pressing the [ENTER] key).
If this warning message appears, ask your local Fostex dealer or service station for replacing

the lithium battery (the battery cannot be replaced by a user).

Warknina

RETC Batters Emrigl
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About memory card

The FR-2 records audio data to a memory card such as a CompactFlash card ("CFC" for
short) and Flash ATA Card (ATA, for short) which are formatted with the FAT32 file
system.

<Note>: A virgin memory card which is FAT32 formatted can be used without the need of
initial-formatting, however, we recommend to format such a card using the "Format" menu
item on the "DISK" menu in the MENU mode. Also, if you use a FAT32 formatted memory card
which has been used with a PC, we recommend to format it in the same manner.

See “Formatting a memory card” on page 76 for details about the “Format” menu item.

Flash ATA Card

CompactFlash card ———»

Inserting/removing a memory card

A memory card should be inserted to the appropriate card slot on the side panel
of the unit. A CFC should be inserted to slot (1), while an ATA should be inserted
to slot (2) in the figure below.

<Note>: You can remove or insert a card regardless of whether the power is on or off,
however, never remove a card while the FR-2 is writing data to the card or reading data
from the card. When you remove or insert a card when the power is on, follow the
appropriate procedures described from the next page. Also be sure to insert a card in
the correct direction and side. Note that Fostex is not responsible for any damage of a
card caused by incorrect card handling. Note that Fostex is not responsible for any
damage of a card caused by incorrect card handling.

* Foste x is not responsib _le for any "direct dama ge" or "indirect dama ge" caused b y using the
unit.

POWER ANALOG OUT

el

gooo20

24

A




FR-2 Field Memory Recorder (Chapter 2: Before using the FR-2)

* Inserting a card

The following description assumes that no memory card is inserted to the unit and
the power is turned on. "NoMemoryCards" is shown on the display.

In the following procedure example, let's assume we are going to use a virgin
CompactFlash card which is FAT32 formatted.

1)

2)

Insert a memory card to card slot (1).
When inserting a memory card to the slot, the display shows the screen for asking
you whether loading the card or not. (If you insert an ATA to slot (2), "Loading:
PCMCIA?" is shown.)
0 . Loadina

< HabemorCards > N
Femain= ——h——mf Loadina: CFC?

LL_: H : H : HEEH I |
WED Y2 30 F 18 B Y 8 0oL
R T T T |

[ T ]
[T T (S—

[ MO 3]

While "YES" is highlighted, press the [ENTER] key.

The FR-2 starts loading the card.

When loading is completed, "<No Files>" is shown on the display, together with the
remaining time (or space) of the card. This shows that no audio file exists on the
card. When making recording, an audio file is automatically created on the card.
For details, see "Chapter 5: Recording/playback" from 47 pages.

Mo Filesk
Femain=33mdds
[ : : : : I
@WED 42 30 Y 12 EYyanool
g T T H T HEEE |

I5 FMAR 08:08

If you load a memory card on which any audio files created by the FR-2 are stored,
the first file in the entry list (“File001”) automatically is selected and the recorder
locates the beginning of that file, while the display shows the Home screen of the file.

*When loading a used FAT32 formatted card

When loading a card which has been used with a PC, etc., the display also shows
"<No Files>", as the screen example above. If any data is recorded on the card, the
remaining space which can be used for recording by the FR-2 may be smaller.
Therefore, we recommend to format the card using the "Format" menu item on
the "Disk" menu in the MENU mode. See "Formatting a memory card" on page 76
for details.

*When loading a card which is not FAT32 formatted

When loading a card which is not FAT32 formatted, the display shows a warning
message ("Illegal Format!"). You need to format the card according to the proce-
dure described in "Initial format of a memory card" on the next page.

Warnina

Illeaal Format!Es:k

Fuskh EHMTEE Eeal
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* How to switch the current card when inserting a card to the other slot

While a card is inserted in either of the card slots, you can insert another card to
the unused card slot and switch the current card.

Assuming that a CFC is currently loaded, the procedure below shows how to switch
the current card from "CFC" to "PCMCIA" after inserting an ATA.

1) While the recorder is stopped, insert an ATA to the PCMCIA slot.
The screen as shown below appears, asking whether loading the inserted
ATA or not.

Loading

Loadina:PCHMCIA?

[_YES ]
[ MO ]

2) While "[YES]" is highlighted, press the [ENTER] key.
Pressing the [ENTER] key releases the current card (CFC, in this case) and
starts loading the newly inserted card (ATA, in this case).
This operation automatically switches the setting of the "Select" menu item
(on the "Disk" menu in the MENU mode) from "CFC" to "PCMCIA".

While memory cards of both types are inserted to the appropriate
slots and the unit is turned on, you can select the current card using
the "Select" menu item on the "Disk" menu in the MENU mode. See
"Selecting the current memory card" on page 74 for details.

<Notes on the current card>

» Ifacard is inserted in either one of the card slots when turning on the unit, the
unit automatically recognizes the inserted card as the current card, and ap
propriately set the "Select" menu item on the "Disk" menu in the MENU mode.
For example, if you insert only an ATA and turn on the unit while the "Select"
item is initially set to "CFC", the "Select" setting is automatically switched to
"PCMCIA",

e If both CFC and ATA are inserted in the appropriate card slots when turning on
the unit, the current card is selected according to the "Select" setting (by
default, it is set to "CFC").

For example, if both CFC and ATA are inserted in the appropriate card slots
and the "Select" item is set to "PCMCIA" when turning on the unit, the ATA is
automatically loaded as the current card.

A
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» Removing a card

The following describes how to remove a memory card from the slot, assuming
that a CFC is inserted to the appropriate slot.

1)

While the recorder is stopped, press the [CARD RELEASE] key.

Pressing the [CARD RELEASE] key brings up the screen as shown below. This screen
shows that a CFC is inserted and mounted, while no ATA is inserted, and is asking
whether releasing the CFC or not.

FR-2 FIELD MEMORY RECORDER

Filesx

CHRED RELEASE

Femain=33msds

| .

EHZO0L

20N

WED 43 3n
F

2)

L : : : : HEHEEH |
IE ST AT I (—

CFC

CFC Eelease Sure?
L YES 1~

: Movinted
FCMCIA:Ho Card

Use the [MENU] dial to select "[YES]" and press the [ENTER] key.

The display shows "Please Wait!", followed by "CARDS Release OK!". When the card is
completely released, the CFC indicator lights.

CARD EELERSE

CARD RELERSE

CARD RELERSE

CFC fMounted
FCMCIA: Mo Card

CFC Release Sure?
<L MO ]

CFC

Y

Flease Wait!

Y

CFC

CARD REelease OK!

"Mounted" and "No Card" shown on screens above mean as below.

Mounted”

The power is delivered to the card drive (the indicator is unlit). You can-
not eject the card until the card is released.

‘ No Card”

No card is inserted to the slot.

3)
slot.

PCMCIA indicator

CFC indicator
& = ~|

While CFC indicator is lit, press the eject key and pull out the memory card from the

Eject key for slot (1) Eject key for slot (2)
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<Notes on ejecting a card when both CFC and ATA are inserted>

When both CFC and ATA are inserted to slots (1) and (2) respectively,
pressing the [CARD RELEASE] key brings up the screen as shown below.
This screen example shows the current card is a CFC and the power is
supplied to the CFC card drive, while an ATA is not mounted. Therefore,
you can eject the ATA, while cannot eject the CFC. In this condition, the
CFC indicator beside the eject key is unlit, while the PCMCIA indicator is
lit. (“Not Mounted” : No power is delivered to the card drive and you can
eject the card (the indicator is lit).

CARD RELEASE

CFC tMounted
FCMCIAiHot Mounted

CFC Release Sure?
S HG 1]

"Mounted" and "Not Mounted" shown on screens above mean as below.

" The power is delivered to the card drive (the indicator is unlit). You can-
Mounted X . .
not eject the card until the card is released.
No power is delivered to the card drive and you can eject the card (the
‘ Not Mounted” | | o POWe''S y ) (
indicator is lit).

To remove the CFC, select "YES" on the screen and press the [ENTER] key,
then press the eject key after the display shows the screen below.

CARD RELEASE

CFC

CRED Release 0Ok

A
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Initial format of a memory card

The FR-2 accommodates memory cards formatted with the FAT32(*) file system.

In the following procedure, it is assumed that a card, which is formatted with a file
system other than FAT32, is loaded, and the display shows the warning message ("Ille-
gal Format!").

1)

2)

While the warning message is shown, press the [ENTER] key.
The FR-2 goes to the "Format" menu item and the display now shows the caution with
flashing "Are you sure?", as shown below.

Warnins MEHURD i sk BFEormat

———CAUTIOH——
I¥+ EHMTER kew is
— Fushed: will start
formattina and
delete All dats!

Il1leaal Format!E#@#®

FPusih EMTER Ked!

If you are sure, press the [ENTER] key again.

Formatting starts and the display shows "Please Wait!", followed by "Completed!" when
completed, and then returns to the Home screen (note that the "Please Wait!" and
"Completed!" screens may not appear when formatting a small size card.

MEHUED sk FFormat MEHUEDL sk FFormat
———FORMATTIMG ! ——— ———FORMATTIMG | ———
- — Remnain=33m2ds
L H H H H H HEHE I_I
Flease Wait! Comeleted! e S e
IETE TR - (S—

After formatting, no file exists on the card, therefore, "<No Files>" is shown on the Home
screen. The remaining time or space on the card for recording is also shown (by default,
the remaining time is shown).

Femain=33mlds

L | H H H H H HEHE

WED Y230 F 13 6 4 gL
(=N T H H H HEH I | |
Now, the memory card is formatted with the FAT32 file system and you can make record-
ing/playback using it. See "Chapter 5: Basic recording/playback" which starts from page
47.

<Volume label>

A volume label is automatically given when a card is formatted. By default, a volume
label is set as below (we call it "default volume label"), depending on the card type. You
can edit the default volume label using the "Volume Label" menu item on the "DISK"
menu in the MENU mode (see page 77).

<Default volume label examples>

ATA -> "PCMO000"
CFC -> "CFCO000"




FR-2 Field Memory Recorder (Chapter 2: Before using the FR-2)

Memo

30

A



FR-2 Field Memory Recorder (Chapter 3: Names and functions)

Chapter 3: Names and functions
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Front panel

1)

2)

3)

4)

5)

6)

3 4 5 6789 10 11

16 15 14 13 12

[PHONES] jack

Connects headphones for monitoring.

Inserting a plug automatically disables the internal monitor speaker.

Note that, regardless of the setting of the "Speaker Mute" menu item on the Setup mode in
the MENU mode, the [PHONES] jack always feeds audio.

See "Speaker mute function on/off" on page 86 for details about "Speaker Mute" setting.

[SP/HP MONITOR] control

Adjusts the monitor level of headphones and the internal monitor speaker.

You can push down the control to the same level as the panel. Pushing the control again
raises it up. Turning the control counterclockwise until clicked turns off the monitor sound.

LCD display
Displays various kinds of information including audio input/output levels, settings, etc.
See "About the LCD display" on page 39 for details.

[HOME/HOLD RESET] key
This key works in the following situations.

<While the HOME screen is shown>
Resets the peak hold on the meters.

<In the MENU mode>
Exits the MENU mode and returns the display to the HOME screen.

[SHIFT] key

To make a SHIFTed function active, press a key which provides its SHIFTed function while
holding down the [SHIFT] key.

Each SHIFTed function is labeled in a rectangular box below the key.

[CUE a«] key
If cue points (CUE 01 ~ 99) are stored in the current file, pressing this key skips back to the
previous cue point. Pressing this key repeatedly skips back to the associated cue point.

When more than one file exists on the card, pressing this key while holding down the
[SHIFT] key switches the current file to the previous entry in the file list.
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7)

8)

9)

10)

11)

12)

13)

14)

[MENU/ENTER] knob
You can rotate or press this knob.

[MENU] dial function:
Rotating this knob selects an item from a menu or a character among alphanumeric
characters in the MENU mode.

[ENTER] key function:
Pressing this knob completes setting or executes the selected operation.

* In this manual, we sometimes call this knob "[MENU] dial" or "[ENTER] key" according to
the function.

[CUE PP key
If cue points (CUE 01 ~ 99) are stored in the current file, pressing this key skips forwards to
the next cue point. Pressing this key repeatedly skips forwards to the associated cue point.

When more than one file exists on the card, pressing this key while holding down the
[SHIFT] key switches the current file to the next entry in the file list.

[ACCESS] indicator

This indicator flashes when the FR-2 is accessing a currently selected card (CompactFlash
card or Flash ATA card). The indicator may light steadily depending on the FS of a
recorded material.

When removing a card, make sure that the [ACCESS] indicator is unlit.

<Warning>: Never turns off the power when the [ACCESS] indicator flashes.
Data currently being recorded or played back may be damaged.

[REC STBY] (RECORD STANDBY) key

Pressing this key before recording makes the unit record-standby and switches the monitor
to “input monitor”.

Pressing this key again releases record-standby (and “input monitor”).

During recording, pressing this key stops recording (you cannot stops recording using the
[STOP] key).

[RECORD] key

Pressing this key starts recording.

Each time you press this key, a new audio file is created.

For details about the file name of an audio file created when recording, see pages 81 and
82. When the PRE REC mode is set to "ON", the previous data stored in the buffer is also
recorded.

Input level controls
Adjusts the input level of analog audio signals.
The controls for L and R channels are ganged.

[PEAK] indicators

When an analog audio input signal overloads, the [PEAK] indicator of the associated
channel lights. You should set the input level appropriately so that the [PEAK] indicator
does not light continuously.

[MARK CUE - DEL CUE] key

By pressing this key during recording/playback or while stopped, the current position data
is stored as a cue point "on the fly".

You can store up to 99 cue points (01 through 99). By default, cue points are labeled as
"MarkO1", "Mark02", etc. according to the order you store points.

Default cue labels can be edited using the Cue menu in the MENU mode.
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15)

16)

By pressing this key while holding down the [SHIFT] key during playback (or while stopped),
the cue point before the current position is deleted.

[LIGHT - CONTRAST] key

By pressing this key briefly, the backlight of the display lights for three seconds and then
automatically turns off.

By pressing down this key for more than two second, the backlight turns continuously on.
To turn off the backlight in this condition, press this key again.

<Note>: When operating the unit on batteries, to save the battery power, we recom-
mend not to keep the backlight continuously on unless it is necessary.

Note that, if you turn off the unit's power while the backlight continuously lights and
then turn on the unit, the backlight continuously lights.

You can adjust the display contrast by pressing this key while holding down the [SHIFT]
key. See "Before using the FR-2" on page 22 for details.

[CARD RELEASE] key

By pressing this key while stopped, the current memory card is released and ready for
being removed from the slot. To remove the card from the slot, press the eject key beside
the slot. See "About memory cards" on page 24 for details.

Top panel

< REWIND FRWD »> PLAY
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17)

18)

19)

20)

21)

22)

Internal monitor speaker
This speaker is used for monitoring.
When a headphones plug is inserted to the [PHONES] jack, this monitor speaker is muted.

You can also select whether or not muting the speaker except during playback using the
"Speaker Mute" menu item on the "Setup" menu in the MENU mode.
See "Speaker mute function on/off" on page 86 for details.

Phones Spe::tfirnEUte During input monitor During recording During playback
Off Input monitor Source monitor Playback monitor
Disconnected
On Mute Mute Playback monitor
Connected - Mute Mute Mute

[FS (kHz)] switch
Selects a sampling frequency (FS) for recording.
You can select a desired FS from among 22.05, 44.1, 48, 88.2, 96, 176.4 and 192 kHz.

<Note>: When recording a digital source whose FS is unknown, the internal clock locks
to the digital source and recording is made with the FS selected by the [FS (kHz)] switch.
If the FS of the digital source is 48 or 44.1 kHz, the internal clock locks to the digital
source and recording is made with the FS of the digital source.

QUANTIZATION switch
Selects a quantization bit (16 and 24 bits) for recording.
You can select from among the following combinations of FS and quantization bit.

16Bit 22.05kHz / 44.1kHz / 48kHz

24Bit 44.1kHz / 48kHz / 882.kHz / 96kHz / 176.4kHz / 192kHz

[PRE REC] switch
Selects ON or OFF of the PRE REC mode.
When it is set to ON, input data is always stored to the internal buffer.

If you start recording when the [PRE REC] switch is set to ON, the previous data is first
delivered from the buffer. You may not miss the start of an important event to be recorded.

The time length of audio stored in the buffer depends on the FS setting. You can edit the
time length using the "Pre Rec Time" menu item on the Setup menu in the MENU mode.
See "Setting the time length stored in the buffer for Pre rec mode" on page 89 for details.

[TRACK MODE] switch
Selects the track mode for recording between STEREO and MONO.

MONO The left channel of a source is recorded in mono.

STEREO | A stereo source is recorded in stereo.

During recording (or input monitor) with the [TRACK MODE] switch set to "MONQO", you
can monitor the source in mono (positioned in center) via headphones.

[LIMTER] switch
Selects ON or OFF of the LIMTER function.
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23)

24)

25)

26)

[LINE/MIC] switches
These switches select analog input sources of the left and right channels between MIC and
LINE. You can select the sources of the left and right channels independently.

[TRIM] controls
These controls adjust the analog input levels of the left and right channels.

When the [LINE/MIC] switch is set to LINE| Adjustable within the range between -30 dBu and +4 dBu.

When the [LINE/MIC] switch is set to MIC | Adjustable within the range between -60 dBu and -26 dBu.

[HPF] switches
These switches select ON or OFF of the high-pass filter (100 Hz,12 dB/oct).

Transport keys

[PLAY] key
Starts playback of the current file.

[STOP] key
Stops the transport.
When the unit is in the MENU mode, pressing this key exits the MENU mode.

Pressing the [F FWD] or [REWIND] key while holding down the [STOP] key moves the
transport as follows.

[STOP] + [REWIND] | The transport locates to the beginning (ABS 0) of the current file.

[STOP] + [F FWD] |The transport locates to the record end position (REC END) of the current file.

[F FWD] key

While stopped, pressing this key fast-forwards the transport.

During playback, pressing this key cues the transport in the forward direction at up to
double speed.

By pressing this key while holding down the [STOP] key locates the record end point (REC
END) of the current file.

[REWIND] key

While stopped, pressing this key rewinds the transport.

During playback, pressing this key cues the transport in the reverse direction at up to
double speed.

By pressing this key while holding down the [STOP] key locates the beginning (ABS 0) of the
current file.

<Note>: With a file recorded at 176.4 or 192 kHz FS, you cannot operate cueing play-
back.
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Left side panel

27)

28)

29)

30)

31)

27

Slot (for the optional card)
Prepared for the optional TC IN/OUT card (available soon).
Ask your local Fostex dealer or sale office for installing the optional card.

[DIGITAL IN)/[DIGITAL OUT] connectors
Both connectors handle AES/EBU or S/P DIF digital audio signals.
The digital input signal format is automatically detected.

The digital output signal format can be selected using the "DigiOutType" menu item on the
"Setup" menu in the MENU mode. See "Setting the digital output signal format" on page 91
for details.

[USB (KEYBOARD ONLY] port

This port is exclusively used for connecting a USB keyboard. By connecting a USB keyboard
to this port, you can edit file and cue point names.

See "Basic connection" on 46 page and the "Selecting the USB keyboard type" on page 93.

[USB (PC ONLY)] port

This port is exclusively used for connecting a PC. By connecting a PC to this port, you can
transfer audio files between the unit and PC.

For details about the file transfer, see "Chapter 7: Exporting files to a PC" on page 97.

DC IN jack
This port is used to connect the optional AC adaptor (Model AD12-1300).

Right side panel
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32)

33)

34)

35)

36)

37)

[POWER] switch
Turns on or off the unit's power.

[ANALOG OUT (L/MONO, R)] jacks (RCA)
These jacks output -10 dBV analog audio signals.
A mono signal is output from the [L/MONO] jack.

[PHANTOM] switch
By setting this switch to ON, +48 V phantom power is supplied to the microphone(s)
connected which requires phantom power.

[ANALOG IN (L/IMONO, R)] connectors
These connectors accept mic or line level analog audio signals. You can adjust the input
level using the [TRIM] controls.

PCMCIA slot/eject key/indicator
A Flash ATA card should be inserted to the slot.
Depending on the condition, the indicator beside the slot is lit or unlit.

When lit No power is supplied to the card in the slot. You can remove the card.

When unlit | The power is supplied to the card in the slot. You cannot remove the card.

To remove a card from the slot whose indicator is unlit, press the [CARD RELEASE] key to
release the card (the indicator turns on) and then press the eject key.
See "About memory cards" on page 24 for details.

COMPACTFLASH CARD slot/eject key/indicator
A CompactFlash card should be inserted to the slot.
Depending on the condition, the indicator beside the slot is lit or unlit.

When lit No power is supplied to the card in the slot. You can remove the card.

When unlit | The power is supplied to the card in the slot. You cannot remove the card.

To remove a card from the slot whose indicator is unlit, press the [CARD RELEASE] key to
release the card (the indicator turns on) and then press the eject key.
See "About memory cards" on page 24 for details.

Bottom panel

38)

38

Battery compartment
This compartment houses eight AA-type batteries for operating the unit. Use alkaline,
Ni-Cd, or Ni-HM batteries. See "About power supply" on page 18 for details.
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Details about screens

The FR-2 features 132 x 65 dot LCD display for showing record/playback levels, file
information, setting information, realtime clock information, etc.

Home screen

After the unit is turned on and starts up, the "Home screen" appears on the dis-
play.

*When no memory card is set
When no memory card is set in the slots, turning on the unit brings up the screen
as shown below after the unit starts up. "<NoMemoryCards>" is shown on the

screen. :
el e
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This screen is called "Home screen". During recording or playback, the Home screen
is normally shown. On the Home screen, you can see the following information.

1 2

|
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6

This area shows the current file number and the cue point information including
the total number of cue points currently set.

Time counter This counter shows the current position of the file in ABS time.

This area shows transport status using symbols. For example, you can see "l"
while stopped, or "@" during recording.

During recording, the settings of the [FS (kHz)], [QUANTIZATION] and [TRACK
4 |FSBITITRMODEMDIGIIN | MODE] switches are shown. During playback, the FS, quantization bit and track
information mode information of the current file is shown. "DIG IN" lights when the unit re-
ceives a digital input signal.

1 | File number/Cue information

Transport status

This indicator shows the battery power condition.

5 | Battery (BATT) indicator When using the AC adaptor, this indicator fully lights.

This indicator shows the internal realtime clock data in "day, month, hour and

6 | Realtime clock indicator minute".

These meter show recording/playback levels of L and R channels. The reference

7 | Level meters
level corresponds to -12 dB.

When recording starts (or input monitor is enabled), this area shows the time or
8 |Remaining time (or space) space remaining on the memory card for recording.

You can select whether to show the remaining time or space (in MBytes) using the
appropriate menu item in the MENU mode.

This area shows the current audio file name.

9 | File name Up to 16 characters can be shown.
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*When a virgin memory card is set

When a virgin memory card (CFC or ATA) is set in the slot, turning on the unit
brings up the Home screen as shown below after the unit starts up.

You can see "<No Files>", as well as the time or space remaining on the current
card for recording. (You can select whether to show the remaining time or space
using the setting of the "RemainDisplay" menu item on the "Setup" menu in the
MENU item. By default, the remaining time is shown.)

ihn Flles}
Remaln—Eum24H

L| H H H - ||:|
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*When a recorded memory card is set

When a recorded memory card (CFC or ATA) is set in the slot, turning on the unit
brings up the Home screen as shown below after the unit starts up.

The recorder is stopped at the beginning of the current audio file ("File 001").

1 mﬂ
Femain=33mzas
L= T T HE I |

au E-El 26 4anoL
I | .
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You can turn on or off the backlight of the LCD display, as well as adjust the
contrast, allowing you to see the display comfortably on any circumstance.
See "Chapter 2: Before using the FR-2" on page 22 for details.

MENU mode screens

By pressing the [ENTER] key while stopped, the FR-2 enters the MENU mode and
the display changes to show the MENU mode screen.

In the MENU mode, the Cue menu, File menu, Disk menu, Setup menu and USB
Mode menu are available. Each menu has various menu items, from which you can
make desired settings according to your system or purpose.

"p" at the right of a menu title shows that the menu has more than one pages.
See from page 61 for details about the MENU mode.

MEHUC1~1 2k |

Cue k
File k
Oisk [
Setur ¥
USE Maode R
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Warning message screen

In a case that the operation is inappropriate, entered data is illegal, or an error
happens, a warning message screen may appear on the display.

The following shows available warning message screen with comments including
remedies. If you encounter any warning message, immediately cope with the trouble.

Wartins
This message appears when batteries for operating the FR-2
Batiers EmFia! are exhausted. The FR-2 automatically shuts down after show-
ing this warning message.

Replace batteries with new (or fully charged) ones.

Warnina

This message appears when the battery for operating the in-
— ternal realtime clock is exhausted. This message appears when
gl
RTC Battery Emei! turning on the power.

Fush EMTER Kegl Ask your local Fostex dealer or sales office for replacing the
battery.

o

—lWarning —m

This message appears when the memory card inserted to the
slot has a problem.

Memora Error!

Fuskh EMTER kel Replace the card with another one.
Warnina .
This message appears when the current memory card does
Memor2 Full! not have enough remaining space for recording.
Replace the card with another one which has enough remain-
Fush EMTER Kew! eP g
ing space.
Warnina .
File Error! This message appears when the current audio file has a prob-
FPush EMTER Kewa! lem. You cannot use this file any more. Delete this file.

This message appears when the current file is protected.
Release the protection using the "Protect” menu item on the
Fush EHTER Kewa! "File" menu in the MENU mode if you wish to make recording
or editing.

Warmning ————
. This message appears when you cannot create an audio file
Too Mang Files! to the current memory card any more.
— To create a new audio file, delete an unnecessary file or re-
Push EMTER Ked! Y
place the card to another one.
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Warning ———.
Cue Data Error!

Fush EHTER EKed!

This message appears when you are going to store illegal cue
point data after editing.
Enter legal cue point data and store it.

—llarning ————.,
Oi=gi In Error!

Fush EMTER Kewdl

This message appears when the digital input signal is illegal
during recording a digital source.
Check the digital source.

—llarning .
Same Hame Exist!
Fush EMTER Ked!

When you are going to store an audio file name, this message
appears if a file with the same name already exists in the card.
Change the audio file name to be stored.

Warning ———.
Can®t Delete
Frotected File!

Fush EMTER Kewg!

This message appears when you are going to delete an audio
file which is protected.

Release the protection using the "Protect” menu item on the
"File" menu in the MENU mode.

—llarning .

Illeaal Hame!

FPush EMTER EKedl

When you are going to store an audio file name, this message
appears if the name is illegal.
Enter a legal name and store it.

. Warning —————,
Ho Memora Cards

Fuskh EMTER Eea!

When you are going to make setting of any menu item (except
for menu items on the Setup menu) in the MENU mode, this
message appears if no memory cards are inserted to the slots.
Insert a memory card and make setting.
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Chapter 4: Basic connections

This chapter describes the basic connection between the FR-2 and external devices.

<Table of contents>
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A

Audio input/output connection

Analog audio device Analog audio device

Digital audio device Digital audio device

Analog audio inputs

The FR-2 provides two [ANALOG IN] connectors (XLR-3-31, pin 2 hot) which ac-
cept two mono or a stereo pair of balanced analog audio source signals.

Each audio input accepts signals of a wide range of nominal input level from -60
dBu (microphone level) to +4 dBu (line level).

You can adjust the level using the [TRIM] controls in conjunction with the [LINE/
MIC] input selector.

When the [LINE/MIC] switch is set to LINE Adjustable within the range between -30 dBu and +4 dBu.

When the [LINE/MIC] switch is set to MIC Adjustable within the range between -60 dBu and -26 dBu.

The FR-2 can provide +48 V phantom power for condenser microphones. It is also
equipped with a HPF (High pass filter) and limiter circuit for each input channel.
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Digital audio input

The FR-2 accepts digital signals conformed to IEC 60958 (AES/EBU) or IEC 60958
(S/P DIF) format via the [DIGITAL IN] connector (XLR-3-31, pin 2 hot). During
recording, the FR-2 automatically detects the format of the digital source.

When the FR-2 receives a digital signal from the [DIGITAL IN] connector, PLL (Phased-
locked loop) activates and the FR-2 locks to the sync signal in the digital input
source.

<Note>: When receiving a digital source which contains FS information, the FR-2 makes
recording according to the FS of the digital source regardless of the [FS (kHz)] switch
setting.

When recording a digital source which does not contain FS information, the FR-2 makes
recording according to the [FS (KHZ)] switch setting.

When receiving a digital source which does not contain FS information and making the
unit “input monitor” (record-standby), “DIG IN” is shown in inverse video on the display.

Dlal

EI 1 3h24m2&|5 1941 EEIIEIR]EEIE
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<Note>: During recording of analog audio, the FR-2 does not receive a digital input
signal.

<Note>: The FR-Z does not accept digital signals at 176.4 kHz and 192 kHz.

Analog audio outputs
The [ANALOG OUT] jacks (unbalanced RCA) output -10 dBV analog audio signals.

Digital audio output

The digital audio signals can be output from the [DIGITAL OUT] connector in the
IEC 60958 (AES/EBU) or IEC 60958 (S/P DIF) format.

You can select the digital output signal format (AES/EBU or S/P DIF) using the
"Digital Out Type" menu item on the "Setup" menu in the MENU mode (the default
is "AES/EBU").

A balanced XLR-3-32 type (pin 2 hot) connector is used.

<Note>: The [DIGITAL OUT] connector does not support digital signals at 176.4 kHz and
192 kHz.
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PC/keyboard Connection

Connecting the FR-2 to a PC

The FR-2 provides the [USB (PC ONLY)] connector which is exclusively used for
connecting to a PC. By connecting this connector to a PC, you can control the
current memory card of the FR-2 from the personal computer.

See page 97 for details about audio file export/import.

<Note>: To use the FR-2 with a personal computer,
make the "USB MODE" setting to "ON". See page 99
for details.

Connecting the FR-2 to a USB keyboard

The FR-2 provides the [USB (KEYBOARD ONLY)] connector which is exclusively
used connecting to a USB keyboard. By connecting a USB keyboard to this connec-
tor, you can enter file/label names, as well as carry out some of menu operations,
from the keyboard.

<Notes>

e The FR-2 must be po wered off when connecting or disconnecting a USB ke yboar d.

e To control the FR-2 from a USB keyboard, make setting of the "Keyboard" menu
item on the Setup menu appropriately ("US" or "JAPAN") according to the
keyboard connected. See "Selecting the USB keyboard type" on page 93 for details.

- With some keyboards, indicators may not light until pressing any key after
connection is made.

» Fostex does not guarantee keyboard operations if you use a keyboard with built-in
USB hub, USB mouse or PS2 mouse.

[wFFFTFTT T FPILII L
T O

T N G G O A
= 1] 0 I

For details about functions you can operate from a USB keyboard, see the descrip-
tion of each menu item with which you can use a keyboard.
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Chapter 5: Recording/playback

This chapter describes basic analog and digital audio recording/playback, as well as cue point
setting and the skip/locate function.

<Table of contents>
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About recording system

The FR-2 uses the FAT32 (File Allocation Table 32) file system and supports the most
common BWF (Broadcast Wave File) file format.

You can make recording in the stereo (L/R) or mono track mode. When recording in
stereo, two (L and R) WAV files are created, while a single WAV file is created when
recording in mono.

A BWF file created is stored in the "bwff" folder which is created on a CFC/ATA (see the
figure below). The FR-2 uses the "1 take - 1 file" system. With this system, each time you
make recording, a new audio file is created on the card. Note that you cannot make
additional recording or overwriting to an existing file.

CFC or ATA

BWFF

—

Fkkk \\ay

*kkk \\ay

ok \\ay/

By connecting the FR-2 to your PC, you can transfer an audio file recorded by the FR-2
to the PC, and vice versa. Therefore, you can copy an audio file recorded by the FR-2 to
a PC hard drive or export it to a computer application such as Digidesign Pro Tools.

The table below shows the approximate recording time on a 1GB card (CFC or ATA).
Note that actual recording time may be slightly different depending on card manufac-
turers.

FS/BIT Recording time in stereo Recording time in mono
22.05kHz / 16bit Approx. 192 minutes Approx. 384 minutes
44.1kHz / 16bit Approx. 96 minutes Approx. 192 minutes
44.1kHz / 24bit Approx. 64 minutes Approx. 128 minutes

48kHz / 16bit Approx. 90 minutes Approx. 180 minutes
48kHz / 24bit Approx. 60 minutes Approx. 120 minutes
88.2kHz / 24bit Approx. 32 minutes Approx. 64 minutes
96kHz / 24bit Approx. 30 minutes Approx. 60 minutes
176.4kHz / 24bit Approx. 16 minutes Approx. 32 minutes
192kHz / 24bit Approx. 15 minutes Approx. 30 minutes
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Recording analog audio

To record analog audio, some control and switch settings are necessary.

Selecting the input source

Set the [LINE/MIC] switch for each (L, R) channel appropriately according to the
source (microphone or line) connected to the associated [ANALOG IN] (L/MONO

or R) connector.

[LINE/MIC] switches

Adjusting the input gain

Using the [TRIM] control for each (L, R) channel, you can adjust the input gain for
the associated channel to accept signal within the following nominal input level
range.

When the [LINE/MIC] switch is set to "LINE" Between -30 dBu and +4 dBu

When the [LINE/MIC] switch is set to "MIC" Between -60 dBu and -26 dBu

[TRIM] control

High-pass Filter

The FR-2 is equipped with the high-pass filter circuit. The cutoff frequency is 100
Hz and the filter slope is -12 dB/oct. The [HPF] switch, which selects ON or OFF of
the high-pass filter, is provided for each channel.

The filter is useful to eliminate the wind noise during location recording or unnec-
essary low frequency noise when recording a voice or sound.

PRE REC

OFF

LIMITER
ON  oFF

® ? [HPF] ON/OFF switch

4 4REWIND FEWD »b PLAY_#- STC

— A —
R8S0
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Limiter

By using the limiter, the signal level is prevented from exceeding a certain level. In
result, the signal level fluctuation is suppressed. Therefore, the limiter is useful
when recording a sound whose level is unknown. You can activate the limiter for
both L and R channels by setting the [LIMITER] switch to "ON".

The FR-2 limiter uses the VCA (Voltage Controlled Amplifier) circuit. By default,
the threshold is -2 dB under the 24-bit full-scale level (all bits: ON) and the com-
pression ratio is 1:5. The limiter attack time is fixed to approximately 20 ms, while
the release time is fixed to approximately 150 ms.

[LIMITER] switch

Selecting the sampling frequency/quantization bit length

You can select the desired sampling frequency ("FS " for short) and quantization

bit length ("Bit" for short) for recording by using the [FS (kHz)] and [QUANTIZA-
TION] switches on the top panel.

You can select the FS from among 22.05 kHz, 44.1 kHz, 48 kHz, 88.2 kHz, 96 kHz,
176.4 kHz and 192 kHz, while you can select the Bit between 16 and 24 bit. The
current FS and Bit settings are shown on the Home screen. See the available com-
bination of FS and Bit settings in the table below.

While receiving a digital signal, the FR-2 automatically detects the FS and Bit from

the receiving digital signal, which takes priority over the [FS (kHz)] and [QUANTI-
ZATION] switch settings.

[QUANTIZATION] switch

[FS (kHz)] switch

LLLLLLLLL
(((((

BIT F
FS (kHz) = - [ BR-AS
it 24bit OFeninaTal k_B881 KA | g—— You can see the current
22.05 Yes EF“{‘EI_*"‘EfE"‘?ES_ FS and bit length.
44.1 Yes Yes ppED Hg 30 en 1znoL
48.0 Yes Yes
88.2 T{es <Note>: During recording (or input monitor), the FS
9 es and Bit follow the current switch settings.
176.4 Yes While stopped (or during playback), the FS and Bit
192 Yes recorded on the current file are shown.

<Note>: During recording, you cannot change FS and Bit setting.

If you change the [FS] select switch setting during recording, the switch setting becomes
effective when recording stops.
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Selecting the track mode

According to the situation, select the track mode (whether making recording in
mono or stereo) using the [TRACK MODE] switch.
The [TRACK MODE] switch setting is shown on the Home screen.

MONO The FR-2 records only the analog "L" input channel signal to a single file.

STEREO The FR-2 records the L and R analog stereo input signals to two individual files.

<Note>: You cannot change the track mode during recording.

QUANTIZATION
18T 24BiT

RACK MODE] switch
()} ]

FS(kHz)
8
48

Adjusting the recording level

The recording level for each channel can be adjusted using the [LEVEL] controls
after pressing the [REC STBY] key to enable "input monitor". The L and R [LEVEL]
controls are ganged.

Pressing the [REC STBY] key again releases "input monitor".

<Notes>

« Adjust the recording level appropriately so that the level meter does not exceed "O
dB". To get the maximum signal-to-noise performance, set the recording level
appropriately so that the meter indication does not exceed "0 dB" but goes up near to
the "0 dB" at the loudest part of the input signal.
The reference level is set to the "-20 dBFS" relative to digital full-scale.
"20" on the meter is labeled in inverse video, showing that it is the reference position.

» You can set the unit to generate the error tone when the input amplifier clips due to
over level by using the "Error tone" menu item on the Setup menu in the MENU
mode. See "Setting error tone output condition" on page 87 for details.

The file name field shows realtime During record standby, "W" and "@"
counter data which is running. are alternately flashing here. [REC STBY] key

Eemam SEmElF!=-

LI T T ]
F=IIIEI:I '-IE au EEl ER N T

15 FAFK I]E ] (—

<Screen example during input monitor>

[LEVEL] controls
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Monitoring recording signals

You can monitor recording signals via headphones (or the internal monitor speaker).
Inserting a plug to the [PHONES] jack automatically disengages the internal speaker,
and you can monitor the signals only via headphones.

The monitor level can be adjusted by the [SP/HP MONITOR] control. This control
is a pushlock type. Pressing on the control knob raises it above the panel to permit
level adjustment. Pressing the control again recesses the knob to avoid accidental
setting changes.

To turn off the monitor sound completely, rotate the control fully counterclock-
wise until it clicks.

You can monitor the recorded signal in mono (center panning) via the [PHONES]

When recording in mono | .
jack.

When recording in stereo | You can monitor the recorded signal in stereo via the [PHONES] jack.

<Note>: While operating the FR-2 on batteries, we recommend not to raise the monitor
volume more than required. Raising the volume consumes more battery power.

Checking the remain for recording

You can see the remaining time or space (in MBytes) of the current memory card

(by default, remaining time).

F.'

file = —— == [ m e T -~ - [m
“Ho Files:

Ho Filesi o F

Femain=1234MEB Femain=32mAEs

Ler i EEI B L-nlun:u TERET E-E B I.i':lél!lll:l—l

mEE 42 3 B L
IHEFAAEA - {S—

1
The remaining space is shown. The remaining time is shown.

T ]
E4 200l

SMARDS:08

The remaining time is calculated based on the current [FS (kHz)] and [QUANTIZA-
TION] switch settings.

Depending on the recorder status, the display shows the remaining value as fol-
lows.

Any condition except
during recording and | The total remaining time or space of the current memory card is shown.
input monitor

When the remaining space
of the current memory card
During recording and | 1S more than 2 GBytes

input monitor

When the remaining space is more than 2 GBytes,
"2000MB" or the equivalent time value is shown.

When the remaining space
of the current memory card | The current remaining time or space is shown.
gets less than 2 Ghytes

<Note>: The remaining time is shown in "*h**m" when it is over 60 minutes, while it is shown in "**m#**s"
when it lowers 60 minutes.
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Making recording

After making the necessary switch/level settings for recording, you can start re-
cording. The following description is assumed that no recording has been made to
the current memory card ("<No Files>" is shown).

<Note>: The digital input signal takes priority over the analog input signals.

Therefore, when the FR-2 is receiving only analog audio input signals, you can record these
analog input signals. However, when the FR-2 is also receiving a digital signal from the [DIGI-
TAL IN] connector as well as analog signals, you cannot record the analog signals.

<Note>: Even if you use a memory card of more than 2GB size, the maximum recording
space for a file is 2GB. You can set the unit to generate the error tone when the remaining
time gets shorter than the specified time by using the "Error Tone" menu item on the Setup
menu in the MENU mode. See "Setting error tone output condition" on page 87 for details.

[REC STBY] key [REC] key

7
MENU

JENTER,
N\

1 Press the [REC STBY] key to make the unit in the record-standby status, and then
slide the [REC] key to start recording.
The FR-2 creates a new audio file ("FileO01") and starts recording.
By default, the real-time clock time data is given as the file name when an audio file
is created (for example, "B13h 24m 20s 19d...").

|".F 22| Bhﬂﬂmﬂﬂ = n

E13hzdmzes19d., .
Femain= 33mr3E==. BElEE _ , Femain= SSmEIEis
Ll:!:IEIJ "IE 3|] IE E"IEII]IEI LIIIEU Ya 30 T

R H H ] R
E

15 baF 09:08

<Note>: If you press the [REC] key without pressing the [REC STBY] key in advance
(i.e. the recorder is not in the record-standby status), it takes approximately one sec-
ond to start recording. To prevent missing the start of an important event to be
recorded, we recommend pressing the [REC STBY] key to make the unit in the record-
standby status before start recording.

<Note>: Using the "Default file name" menu item on the Setup menu in the MENU
mode, you can set the default file name given when an audio file is created to "de-
sired scene name + take number" (the "SCENE NAME + TAKE NUMBER" option) in-
stead of the real-time clock time data (the "DATE" option).

See "Setting the default file name" on pages 81 and 82 for details.

2. To stop recording, press the [REC STBY] key.
During recording, only the [REC STBY] key is valid. You cannot use the [STOP] key to
stop recording. If you press the [REW] key while holding down the [STOP] key after
stopping recording, the recorder locates to the beginning of the newly created audio
file. You can review the recording by pressing the [PLAY] key in this condition.

> 53
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<Note>: Every time you start recording after stopping recording, a new audio file is created
and recording is made from the beginning of the new file ("one take - one file"). Each time a
file is created, the file number increases.

Recording with PRE REC active

If you start recording when the [PRE REC] switch is set to ON, the previous data is
first delivered from the buffer. You may not miss the start of an important event to
be recorded.

You can edit the time length of audio stored in the buffer in one second steps
using the "Pre rec time" menu item on the Setup menu in the MENU mode. The
adjustable range of the time length depends on FS. See page 89 for details.

Note that recording stops after executing "post recording" which records audio
data currently stored in the buffer (actually, the incoming audio data is first stored
in the buffer and then recorded to the card, therefore, there is a time lag).

<Caution>: If you change the FS setting just before starting recording with the Pre rec mode
active, wait for 10 or more seconds before starting recording. Otherwise, the audio signal
currently stored in the buffer is recorded with altered pitch.

<Note>: Until the buffer is filled with audio data, the [REC STBY] indicator flashes. When it is
filled up, the [REC STBY] steadily lights.

QUANTIZATION
168IT  24mIT

FS(kHz)

[PRE REC] switch

LIMITER
ON  oFF

About overloading
When the FR-2 receives analog audio signals and the input amplifier (for L or R)
clips, the corresponding PEAK indicator lights up in red.

You can also set the FR-2 to generate the error tone from the internal speaker or
headphones for warning when the input amplifier clips.

The setting can be done from the "Error tone" menu item on the Setup menu in
the MENU mode. See "Setting error tone output condition" on page 87 for details.

<Note>: Note that if the [SP/HP MONITOR] control is set to "OFF", you cannot hear the error
tone.

FR-2 FIELD MEMORY RECORDER

[PEAK] indicators
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Recording digital audio

Before executing recording of digital audio, you have to make the following settings.
You do not have to adjust the input level.

See also "Monitoring recording signals" and "Recording with PRE REC active" described
earlier in "Recording analog audio". The description can be applied to the digital audio
recording.

[QUANTIZATION] switch

[TRACK MODE] switch

[FS (kHz)] switch

Selecting the track mode

According to the situation, select the track mode (whether making recording in
mono or stereo) using the [TRACK MODE] switch.
The [TRACK MODE] switch setting is shown on the Home screen.

MONO The FR-2 records only the L channel signal in the digital input signal to a single file.

STEREO | The FR-2 records L and R signals in the digital input signal to two individual files.

<Note>: You cannot change the track mode during recording.

Selecting the sampling frequency/quantization bit length

The FR-2 records a digital audio signal at the same ES as the source signal if it
contains FS information.

However, if a source signal does not contain FS/Bit information, the FR-2 follows
the settings of the [FS (kHz)] and [QUANTIZATION] switches on the top panel.
While the FR-2 is receiving a digital signal which does not contain FS information,
"DIG IN" is shown in inverse video (see pages 39 and 45 for details).

<Note>: The FR-2 does not support digital signals at 176.4 kHz and 192 kHz FS.
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Setting cue points

The FR-2 can store cue points, which can be used as markers. You can manually set and
store a cue point at the desired position during recording (or while stopped).

<About MARK 00 and MARK E>

When you finishes audio recording, the FR-2 automatically set "MARKOO" and "MARK E" at the
beginning and end points of the recording, respectively. These points correspond to "ABS 0"
and "REC END" points, to which you can locate or skip. Note that, unlike other cue points you
store at desired positions, you cannot delete these points, as well as edit point data and names.

Setting a cue point on-the-fly

You can set a "cue point" at the position you press the [MARK CUE] key during
recording/playback or while stopped. Up to 99 cue points can be set (stored).

REC STBY

FR-2 FIELD MEMORY RECORDER

PHONES

[MARK CUE] key

Pressing the [MARK CUE] key sets a cue point at the current position.
The least number unused for the existing cue numbers is assigned to the cue
number automatically.

<About default cue name>

A default cue name (from among MarkO1 through Mark99) is given to a cue point you
set at the desired position. You can edit the default cue name using the "Rename" menu
item on the Cue menu in the MENU mode. See "Editing a cue name" on page 64.

Cue points stored can be used for the locate and skip functions.

From the Cue menu in the MENU mode, the following functions regarding cue
points are available.

* Editing a cue hame

* Editing a cue position
* Locating to a cue point
* Deleting a cue point

See "MENU mode" from page 63 for details about cue name editing, cue position
editing and cue point deletion. See "Locate/skip functions" on page 59 for details
about cue point location.

A
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Viewing cue point information

On the Home screen, you can see the total number of cue points currently stored,
as pointed by the arrow below.

In the screen example below, eight cue points are currently stored and the current
recorder position is "ABS 0".

D

|:|F'F'r"1 r'ralek FIEH =|a|~*
Femalin= ‘EE'-mEEIs
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<About cue point information>

The cue point information field on the Home screen looks different depending on the cur-
rent recorder position and the total number of cue points currently stored.

The following table shows some examples of cue point information.

This information field helps you when deleting a cue point (see the next paragraph below).

“C 00/08" The total number of cue points currently stored is eight. The current recorder position is
between ABS 0 and CUE 01 (including ABS 0, excluding CUE 01).

"C 02/08" The total number of cue points currently stored is eight. The current recorder position is
between CUE 02 and CUE 03 (including CUE 02, excluding CUE 03).

"C 00/00" No cue point is stored. The current recorder position is between ABS 0 and REC END
(including ABS 0, excluding REC END).

"C E/08" The total number of cue points currently stored is eight.
The current recorder position is REC END.

Deleting a cue point in real-time

During playback (or while stopped), pressing the [MARK CUE] key while holding
down the [SHIFT] key deletes the cue point before the current recorder position in
real-time.

For example, if the cue point information on the Home screen shows "C 03/08",
operating as above deletes cue 03.

[SHIFT] key

REC STBY

FR-2 FIELD MEMORY RECORDER

PHONES

[MARK CUE] key
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Playback

Normal audio playback

1) Make sure that a recorded card is set to the slot.

2) Select a desired audio file.
You can select an audio file by either of the following two ways.

<Selecting using the CUE ( l4«4/»») keys>
While the recorder is stopped, pressing the [l¢«] or [»»] key while holding down
the [SHIFT] key selects the previous or next audio file (the recorder skips to the
beginning of the selected file).

<Selecting an audio file using the "Select" menu item on the File menu>

Pressing the [ENTER] key while the recorder is stopped enters the MENU mode,
and the display shows the screen for selecting a menu.

Use the [MENU] dial to select "File" and press the [ENTER] key.

The display now shows the file list.

Use the [MENU] dial to select the desired file and press the [ENTER] key. In the
screen example below, file names are given with the "Default file name" set to

"Date".

MEMLICL 13k MEMUBFileCH]-<H]1 3k
44Back
Cue B BE1:BEZ2h1SmiHs 194... k

I > 07:EAd4hZimlEs19d. b
Oisk b HEZ:BRERBEMIZs 13d... F
Setur k HE4:B1Z2hASmdSs 194, #
USE Mode B BAES:Bl1Sh4Z2mEls13d.. #

The display now shows the Home screen, on which you can see the recorder
stops at the beginning of the selected file.

3) Press the [PLAY] key to start playback.
The [PLAY] indicator is lit.

4) The playback sound can be monitored via headphones or the internal speaker.

5) To stop playback, press the [STOP] key.

Playback in the CUE mode (Cueing playback)

During playback, pressing the [F FWD] (or [REW]) key enters the cue mode. In this
mode, you can hear the playback sound at up to twice the normal speed in the
forward direction or at the normal speed in the reverse direction.

<Note>: Cueing playback is not possible with a file recorded at 176.4 or 192 kHz FS .

A
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Skip/locate functions

The FR-2 offers comprehensive skip/locate functions.

Skipping by file

When more than one audio file is created on the current card, you can immedi-
ately skip to the beginning (ABS 0) of a desired track.

When the recorder is stopped, pressing the [i4«] or [»»] key while holding down
the [SHIFT] key skips forward or backward a file. Therefore, by pressing the [i««] or
[»»] key as many times as required, you can skip to the beginning of the desired
file.

Skipping by cue point

You can immediately skip to a desired cue point on the current audio file.
By pressing the [ie«] or [»»] key while the recorder is stopped, you can skip to the
next or previous cue point.

Locating to the beginning (ABS 0) of a file

While the recorder is stopped, pressing the [REWIND] key while holding down the
[STOP] key locates to the beginning (ABS 0) of the current file immediately.

Locating to the end (REC END) of a file

While the recorder is stopped, pressing the [F FWD] key while holding down the
[STOP] key locates to the record end position (REC END) of the current file imme-
diately.

Locating to the desired cue point

You can locate the recorder immediately to a desired cue point by selecting the
cue point from the cue list.

1) While the recorder is stopped, press the [ENTER] key to enter the MENU mode.

2) Use the [MENU] dial to select "Cue" and press the [ENTER] key.
The current cue point list is shown on the display.

3) Use the [MENU] dial to select the desired cue point and press the [ENTER] key.
The display now shows the Cue menu for selecting a desired cue menu items.

4) Use the [MENU] dial to select "Locate" and press the [ENTER] key.

The recorder immediately locates to the selected cue point and the display returns to
the Home screen.
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Chapter 6: MENU mode
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Menu mode outline

By pressing the [ENTER] key while the recorder is stopped, the FR-2 enters the MENU
mode and the display changes to show the screen as below.

Cue

File
Oisk
Setur

USE Mode

MEHUC1-1 2k

4
4
4
4
F

This screen is the first layer in the MENU mode and used for selecting the desired menu.
As you can see on the screen above, the available menus are "Cue menu", "File menu",
"Disk menu", "Setup menu" and "USB Mode menu".

On each menu, the following menu items are available.
By selecting "««Back" and pressing the [ENTER] key, you can return to the previous screen.

Menu

Description

Menu items

Cue menu

This menu offers items re-
garding existing cue
points.

Locate (Locating to a cue point)
Rename (Renaming a cue point)
Edit (Editing a cue point)

Delete (Deleting a cue point)

File menu

This menu offers items re-
garding existing audio
files.

Select (Selecting a file)

Rename (Renaming a file)

Delete (Deleting a file)

Protect (Protecting a file)

Restore (Restoring a deleted (hidden) file)

Disk menu

This menu offers items re-
garding memory cards.

Select (Selecting the current drive)

Optimize (Optimizing a card)

Format (Formatting a card)

Volume Label (Editing a volume label of a card)
Disk Info (Viewing information of a memory card)

Setup menu

This menu offers prefer-
ences/setup items of the
FR-2.

File Name Mode (Selecting default file name type)

Default Scene Name (Setting the default scene name and
take number used for a file name)

Adjust Real Time Clock (Adjusting the real time clock)
Speaker Mute (Speaker mute function on/off)

Error Tone (Setting error tone output condition.)

Peak Hold Time (Setting the peak hold time of the level meters)
Pre Rec Time (Setting the time length of audio stored in the
buffer)

Remain Display (Selecting the remain display mode)

Digi Out Type (Setting the digital output signal format)
Battery (Selecting the battery type)

Keyboard (Selecting the USB keyboard type)

Version (Checking the ROM version)

Init Setup (Initializing settings of the Setup menu)

USB mode menu

*

USB mode on/off for file transfer between the FR-2 and a PC

See the following pages in this chapter for details about each menu item, except for the
USB mode menu which is described in "Chapter 7: Exporting files to a PC".

3
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Cue menu

The Cue menu offers the following four menu items.

* Locate: locating to a desired cue point
* Rename: Renaming a cue point

* Edit: Editing time data of a cue point

* Delete: Deleting a cue point

<Note>: To carry out operations of Cue menu items, one or more cue points must be set to the
current audio file.

Locating to a cue point (Locate)

The following description is assumed that the FR-2 is now in the MENU mode by
pressing the [ENTER] key while the recorder is stopped.

1) Use the [MENU] dial to select "Cue" and press the [ENTER] key.
The display now shows the cue point list in which all cue points stored in the current file

are shown.

MEHUC1-13F MEHUFCL=CA1-812 |
44Back ki

g Cus B | CAliMarkiEl 3
File F — CRZ:Markgz [
Disk [ CAZiMarka3 3
Setur F CHd: Mark g [
USE Mode F CAS: MarkB&5 k

In the screen example above, five cue points are stored with the default cue names. Up
to five cue points can be shown on a single page. If more than five cue points are
stored, the list screen has more than one page.

At the upper right of the screen, you can see the current page and the total page
number. If "(01/02)" is shown, the cue point list has 2 pages and the display currently
shows page 1).

When the cue point list is shown, you can see the time data of each cue point by
pressing and holding down the [SHIFT] key. Releasing the [SHIFT] key returns the
screen to show the file name.

MEHUECLe (81 813 | MEHUFCusCH1 <813

CRi:8kh B32m Sls
— CRZi8h B89m 25s

CHliMark8l :

CRZ: Markfs I CRZ:Eh 18m 1Ts
4
L

CEZ:Marki2

CEd:ifh 1Em 41s

Cad:Marked -
CES:8h 18m 3is

CA5: MarkB5

b il . il i

2) Use the [MENU)] dial to select a desired cue point and press the [ENTER] key.
The display now shows the Cue menu.(In the screen example above, "CO1:MarkO1" is

selected.)

MEHUFCus CR1<E1 2 MEMUECLeFCusR1 (1 <10k
44Back ¥

o CHl:Markdl I Locate
CRZiMarkaz —» | Rename Ik
CaZiMarkia F Edit I
Cad:Markad [ Oelete
CAS: MarkBS I

3) Use the [MENU] dial to select "Locate" and press the [ENTER] key.
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The display now shows the screen as below, and the recorder immediately locates to the
selected cue point. When the locate operation is completed, "Completed!" is shown on the

screen, and then the display returns to the Home screen.

MEMUECLeCusR1 (1 <10k

44Back

5 Locate

Fenamns 3
Edit I
Oelete

"FOO1": Current file name
"CO1": Current cue number and cue name

MEMUECLeFCusll FLocate

“locate Cusflx

FRE E shepsekebokepaeg
CE1:Markal

Flease lLlait!

When a USB keyboard is connected to the FR-2, you can carry out the following operation.

t key

Acts the same as the [MENU] dial on the FR-2 panel.

< key

Returns to the previous screen layer.

Enter key

Acts the same as the [ENTER] key on the FR-2 panel.

Renaming a cue point (Rename)

The following description is assumed that the FR-2 is now in the MENU mode by

pressing the [ENTER] key while the recorder is stopped.

1) Use the [MENU] dial to select "Cue" and press the [ENTER] key.

The display now shows the cue point list in which all cue points stored in the current file

are shown.

MEMHUS L1 2k

_44Back

““File b
Oisk 4
Setur 3
USE Made b

MEMUFCLe CE1-H1 3
¥

CEl:Markal
CRz:Markaz
CRZ:MarkBa3
Cad:Mark8d
CAS:Markg3

b e i e i

2) Use the [MENU] dial to select a desired cue point and press the [ENTER] key.
The display now shows the Cue menu.
(In the screen example above, "CO1:Mark01" is selected.)

MEHUFCUsCE1 <813

44Back

5 CAL:Markal
CAZ:MarkB2
CAZ:MarkBa3
Cad:Markad

e e i il

CR5:Mark@s

MEHUECLeCusR1 1l <10k

T

Locate
Fenamns F
Edit I
Oelete

3) Use the [MENU)] dial to select "Rename" and press the [ENTER] key.

The display now shows the screen as below, on which you can edit the cue name.

The cursor in [ ] is called "cue name cursor", while the cursor in the character options is

MEMUFCUebCusB1Cl<10k

44Back
Locate
H Fename
Edit
Oelete

e

called "character selection cursor".
You can move the character selection cursor by using the [MENU] dial.

MEHUFCUe FCUusi ] FRenams
[ METE )] 1
_ABCOEFGHI.JELEHOPOR

STULWEYZR1 2345872902
~abcdefahidk lmnoFar
stuigxaz L E-av #

L+ +IIMNSITDEL IL Ok ]
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4)

5)

6)

Enter the desired cue name.
See the table below for details about how to enter a name. Up to 32 characters can be
entered.

To edit a character | Use the [MENU] dial to select a desired character from among the character op-
highlighted (on the | tions, and press the [ENTER] key. The selection is fixed and the cue name cursor
cursor position) moves right.

To move the cue name | Use [|<<] or [>>]] key. Or use the [MENU] dial to select "<-" or "->" in the character
cursor position options, and press the [ENTER] key.

After moving the cue name cursor to the desired position, move the character selec-
tion cursor to "INS" at the bottom, and press the [ENTER] key. (The FR-2 is put into
Inserts afrontspace at | the INSERT mode and the cue name cursor condition changes to be lit solid.) After
the cue name cursor | that, select the character that you would like to insert by the character selection
position cursor and press the [ENTER] key again. In order to cancel the INSERT mode,
select the “INS” and then the [ENTER] key. (The cue name cursor condition changes
to be flashing.)

To delete a character
on the cue name cur-
sor position

After moving the cue name cursor to the desired position, move the character selec-
tion cursor to "DEL" at the bottom, and press the [ENTER] key.

Move the character selection cursor to "OK", and press the [ENTER] key.

The FR-2 starts the operation for storing the entered name. When completed,
"Completed!" is shown on the screen and the display returns to the cue point list screen
as shown below.

MEHUECuE FCusB 1 FRenams MEHUECue CE1 813

C ] 44Back
(MR HE I E Y
—»| LCEZIiMark@2
CEI:Marki&3
Completed! CE4:Mark@d
CHS: Marki5S

You can enter up to 32 characters, however, only 16 characters can be displayed.
If a name has more than 16 characters, "->" is shown on the right of [ ].

b il e i,

Press the [HOME] key to exit the MENU mode.

When a USB keyboard is connected to the FR-2, you can carry out the following operation.

You can directly enter a character instead of selecting from among the character

E;asracter/numerlc options on the screen. Each time you press a character key, the cue name cursor
4 moves right.

A key Acts the same as the [MENU] dial on the FR-2 panel.

</ = key Moves the cue name cursor right and left.

Deletes the character at the cue hame cursor position, and slides all the subse-

Back space key
quent characters left.

Turn ON and OFF the INSERT mode. When it is ON, the cue name cursor is lit

Insert ke
y solid. When it is OFF, the cue name cursor is flashing.

Delete key Deletes the character at the cue name cursor position.

Used to fix the name entered.
Enter key Acts the same as moving the character selection cursor to "OK" and pressing the
[ENTER] key on the FR-2 panel.
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Editing time data of a cue point (Edit)

The following description is assumed that the FR-2 is now in the MENU mode by
pressing the [ENTER] key while the recorder is stopped.

1)

2)

3)

4)

5)

6)

7

Use the [MENU] dial to select "Cue" and press the [ENTER] key.
The display now shows the cue point list in which all cue points stored in the current file
are shown.

HMEHUC1-1 2k MEHUFCus A1 <813 |
4Back v

g Cue k CRI:MarkAl B
File F ——»| CRZ:Markaz 3
Disk 3 CAZ:Markfs 3
Setur 3 Cad:Markad [ 3
USE Mode B CAS: MarkAS 3

Use the [MENU)] dial to select a desired cue point and press the [ENTER] key.
The display now shows the Cue menu. In the screen example above, "CO1:Mark01" is
selected.

MEHUFCus CR1 <812 MEHUFCuUs FCusB1 110k
44Back ¥

= I Locate
CRZ:Markaz F—| Esname k
CRZ:MarkBa3 I Edit
CEd:Markad 3 Oelete
CAS:MarkB8s k

Use the [MENU] dial to select "Edit" and press the [ENTER] key.
The display now shows the screen as below, on which you can edit time data of the cue
point (initially, the minute field flashes).

MEHUFCLuebCueB1 (1 10k MEHUFCLueFCusE1l FEDI L
44Back <Edit Cuefl>
Locate FRIET 3 sekeokspestooksotokskor
Renams 2 O CHl:iMarkil

= Edit [ Bk [23Im [45.6721s
felete

Fush EMTER EKewa!

Use the [MENU)] dial to enter the desired value in the hour field and press the

[ENTER] key.

The value is fixed and the cursor moves to the left part of the decimal point in the minute
field.

Use the [MENU] dial to enter the desired value in the minute field and press the

[ENTER] key.

The value is fixed and the cursor moves to the left part of the decimal point in the second
field.

Use the [MENU] dial to enter the desired value at the left part of the decimal point in

the second field and press the [ENTER] key.
The value is fixed and the cursor moves to the right part of the decimal point in the
second field.

Use the [MENU] dial to enter the desired value at the right part of the decimal point in

the second field and press the [ENTER] key.
The FR-2 starts the operation for storing the edited time data. When completed,
"Completed!" is shown on the screen and the display returns to show the Home screen.

<Note>: Depending on time data to be stored, the cue number may be changed.
In the example above, the entered time data is stored to Cue 03.

J
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<Note>: If you are going to store illegal time data, "lllegal time!" flashes on the
display and you cannot store the time.

When a USB keyboard is connected to the FR-2, you can carry out the following operation.

+ 1 key Acts the same as the [MENU] dial on the FR-2 panel.
< key Returns to the previous screen layer.

Enter key Acts the same as the [ENTER] key on the FR-2 panel.
Numeric keys You can directly enter time data.

Deleting a cue point (Delete)

The following description is assumed that the FR-2 is now in the MENU mode by
pressing the [ENTER] key while the recorder is stopped.

1) Use the [MENU] dial to select "Cue" and press the [ENTER] key.
The display now shows the cue point list in which all cue points stored in the current file

are shown.

MEHUCL 10k MEHUECue Bl 813 |
4 dBack v

> CAl:iMarkal 2
File 2 —»| CAZ:Mark8z 2
Disk 2 CRI:MarkR3 2
SetuF F Cad:Markfd F
USE Mode B CAS: Markfs I

2) Use the [MENU)] dial to select a desired cue point and press the [ENTER] key.
The display now shows the Cue menu. In the screen example above, "CO1:Mark01" is

selected.

MEHUFCus CE1 <812 MEMUECLeFCusR1 (1 <10k
44Back ¥

o CHl:Markil I Locate
CRZ:Markaz F—» | Rename Ik
CRZ:MarkB3 [ Edit I
Cad: Markad I Oelete
CAS: MarkB8s I

3)

Use the [MENU] dial to select "Delete" and press the [ENTER] key.

The FR-2 starts deleting the selected cue point. When completed, "Completed!" is shown
on the screen and the display shows the Home screen, on which you can see the number
of cue points decreases by one.

If you switch to the cue point list screen, you can see "MarkO1" has been deleted, while
"Mark02" and subsequent cue points slide up, as shown in the screen example below.

MEMHUFCus CH1 < H1 3 |
¥

CaliMarkaz
CRZ:MarkR3
CaZ:Markfd
Cad:Markas

bl e i

When a USB keyboard is connected to the FR-2, you can carry out the following operation.

+1 key Acts the same as the [MENU] dial on the FR-2 panel.
< key Returns to the previous screen layer.
Enter key Acts the same as the [ENTER] key on the FR-2 panel.
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File menu

The File menu offers the following five menu items regarding existing audio files.

* Select: Selecting an audio file to be played back
* Rename: Renaming an audio file

* Delete: Deleting an unnecessary audio file

* Protect: Select audio file protection on/off

* Restore: Restoring a deleted (hidden) audio file

<Note>: To carry out operations of File menu items, one or more audio files must be stored to the
current memory card.

Selecting an audio file to be played back (Select)

The following description is assumed that the FR-2 is now in the MENU mode by
pressing the [ENTER] key while the recorder is stopped.

1) Use the [MENU] dial to select "File" and press the [ENTER] key.
The display now shows the audio file list in which all recorded audio files on the current
card are shown (in the screen example below, each file name is shown as something like

Mkkki
)- MEHUC1-1 0k MEMUBFiled(Bl - B12k
44Back ki
CLe | FIE L 2 shsberksberkaokaok

S File kT
Disk ] 2 HE R L
Setur 3 FIE 8 esbotekeokiohohsbabookooke
USE Mode k FIRIS S shesekseoksk

4
4
4
4
F

In the screen example above, you can see five audio files are stored. Up to five audio files can be shown on
a single page. If more than five audio files are stored, the list screen has more than one page. At the top of
the screen, you can see the current page and the total page number. If "(01/02)" is shown, the audio file list
has 2 pages and the display currently shows page 1).

2) Use the [MENU] dial to select a desired audio file and press the [ENTER] key.
The display now shows the File menu. In the screen example above, file "003" is selected.

MEHUEFiletBl- A1)k MEHUEFilekFileBRZC1 12
44Back W d4Back
FIRN] 3 sheobsterkisteokisookisk Select
FIRIZ 2 sesksteokobeookat — Renams 4

=Nz sk ok kR Oelete F

7
FIRIG 5 seoksokokoteokatokapokok Protect 2 OffF

EES:

3) Use the [MENU)] dial to select "Select" and press the [ENTER] key.
The display now shows the screen as shown in the middle below and the recorder starts
loading the file. When the operation is completed, the display shows the Home screen of
the selected audio file.

MEHUFFilekFileARAZcl-13) MEHUERFilekFilefd]l kFoel

™ bk

44Back {Select FileBE3>
Renams 3 FREZE sekokkstokok *Eemai.rFSfEm?Elsl Eﬂ!ﬂ
Eﬁﬁ;gt EDFF WED W2 30 PN s 5 g 0oL
‘ : I N S S N N
Please Wait! [T - (w—

When a USB keyboard is connected to the FR-2, you can carry out the following operation.

+ | key Acts the same as the [MENU] dial on the FR-2 panel.
< key Returns to the previous screen layer.
Enter key Acts the same as the [ENTER] key on the FR-2 panel.
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Renaming an audio file (Rename)

The following description is assumed that the FR-2 is now in the MENU mode by
pressing the [ENTER] key while the recorder is stopped.

1)

2)

3)

4)

Use the [MENU] dial to select "File" and press the [ENTER] key.
The display now shows the audio file list in which all recorded audio files on the current
card are shown.

MEHUCL-1 3k MEHUBRFileCcBl<E12pk
14Back
Cie I FIE L 8 shobsbsbeobobohgop F
g File b e e R 3
Disk [ FIRIS S shokeokosbstoshohokobok E
Setur I FIEE B sheokohsbststeokohsbokiobag 3
USE Mode K FIEIS 2 shesbeokeokenkink [

Use the [MENU] dial to select a desired audio file and press the [ENTER] key.
The display now shows the File menu. In the screen example above, file "004" is selected.

MEHUEFile 81813k MEHUEFilekFileBB4 0112
44Back
FIE ] & shokokohshshohabn F Select
FIEIE B skeskeokokokokohiok Fl—» Renames 3
FIFIE S seckeokokotebookekotok |3 Oelete I
= [ Protect 2 OFf

HEEEE L
BIET & * F

Use the [MENU] dial to select "Rename" and press the [ENTER] key.
The display now shows the screen as below, on which you can edit the file name.

MEHUEFilekFilefB401-12 MEHUEFilekFileffdkRen
44Back i+
Select _ABCOEFGHI.JEL HOPGE
Eename 3 STULEYZR1 234587330 3
felete [ ~abcdefahidk lmnoFar
Protect P OOFF stuvwaz | Ex-a

[+«I+ I INSICDEL JLOK ]

The cursor in [ ] is called "file name cursor", while the cursor in the character options is
called "character selection cursor”. You can move the character selection cursor by using
the [MENU] dial.

Enter the desired file name.
See the table below for details about how to enter a name. Up to 32 characters can be
entered.

To edit a character | Use the [MENU] dial to select a desired character from among the character options,
highlighted (on the and press the [ENTER] key. The selection is fixed and the file name cursor moves

cursor position) right.

To move the file name Use [I<<] or [>>I] key. Or use the [MENU] dial to select "<-" or "->" in the character
cursor position options, and press the [ENTER] key.

After moving the file name cursor to the desired position, move the character selec-
tion cursor to "INS" at the bottom, and press the [ENTER] key. (The FR-2 is put into
Inserts a front space | the INSERT mode and the file name cursor condition changes to be lit solid.) After
atthe file name cursor | that, select the character that you would like to insert by the character selection
position cursor and press the [ENTER] key again. In order to cancel the INSERT mode,
select the “INS” and then the [ENTER] key. (The file name cursor condition changes
to be flashing.)

To delete a character
on the file name cur-
sor position

After moving the file name cursor to the desired position, move the character selec-
tion cursor to “DEL” at the bottom, and press the [ENTER] key.
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5) Move the character selection cursor to "OK" and press the [ENTER] key.
The FR-2 starts the operation for storing the entered name. When completed,
"Completed!" is shown on the screen and the display returns to show the audio file list
screen as below.

MEHUFFilekFilelidkRen MEHUEFiletRl-fHl2k
[ABCEFGHIJKL 1 44Back

FIE L 8 shoksbsboteokohahg

| FIEZE seckoksksckoksk

BIELS § skobskobob bbbk

ComrFleted!

™ i

You can enter up to 32 characters, however, only 16 characters can be displayed. If a
name has more than 16 characters, "->" is shown on the right of [ ].

<Note>: If you are going to store a name which already exists on the file, "Same name
exist!" flashes on the display and you cannot store the name.

If you are going to store an illegal name, "lllegal name!" flashes on the display and the
operation is canceled.

6) Press the [HOME] key to exit the MENU mode.

When a USB keyboard is connected to the FR-2, you can carry out the following operation.

You can directly enter a character instead of selecting from among the character

Character keys options on the screen. Each time you press a character key, the file name cursor
moves right.

+ 1 keys Acts the same as the [MENU] dial on the FR-2 panel.

</ —> keys Moves the file name cursor right and left.

Deletes the character at the file name cursor position, and slides all the subse-

Back space ke
P y quent characters left.

Turn ON and OFF the INSERT mode. When it is ON, the file name cursor is lit

Insert ke
y solid. When it is OFF, the file name cursor is flashing.

Delete key Deletes the character at the file name cursor position.

Used to fix the name entered.
Enter key Acts the same as moving the character selection cursor to "OK" and pressing the
[ENTER] key on the FR-2 panel.

Deleting an audio file (Delete)

The following description is assumed that the FR-2 is now in the MENU mode by
pressing the [ENTER] key while the recorder is stopped.

1) Use the [MENU] dial to select "File" and press the [ENTER] key.
The display now shows the audio file list in which all recorded audio files on the current
card are shown. If more than five audio files are stored, the list screen has more than one

page.
MEMUCT-1 3k MEHURFile(81l- 813k
44Back
Cue I FIEI ] 8 shebeokeokeokesbobonkeoks 3
g File b B g BT R 3
Disk 3 BRI S shesbebeteobsbabbebeok 3
Setur I FIR 8 sesteokeokohshsbokohok 3
USE Mode HRS: * k
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2)

3)

4)

5)

Use the [MENU] dial to select a desired audio file and press the [ENTER] key.
The display now shows the File menu. In the screen example above, file "003" is selected.

MEHUBFile(81- 813k MEHUFFilekFileRR3C1l-12
44Back ¥
FIRT & seskeokapokokaoksk Select
FIFIZ & sheseokeokeokesbenkenks — Renamns 3

= [elete 3

FIRIG 5 shsteokeokateskeoksteokapokg Protect 2 OFF

BIRSE kekkeok

4
4
b
b
|

Use the [MENU] dial to select "Delete" and press the [ENTER] key.
The display now shows the screen as below. "Sure?" lits, asking you whether you are sure
to delete the selected file.

MEHUEFilekFileRB3(1-12 MEHURFilekFileBRZkDel
44Back “helete File@R3:
Select
Rernames e —— | FRIEEE deokkokbkokkobok

T Protect ! OFf

I .. = I

To cancel the operation for deleting the file, press the [HOME] key to exit the MENU
mode.

Press the [ENTER] key to delete the file.
The FR-2 starts the operation for deleting the
audio file. When completed, "Completed!" is shown on the screen and the display returns

to show the audio file list. In the file name field of the deleted file, “C ®1” is shown.

MEMHUFFilekFilefA3rDel MEHUBRFile(81- 813k
thelete Filef@3 44Back
FIFIL 2 shesteokteokateokateok
FRRADE soksoksoksokook | EREE sk

FRSE [@ ] sk
FAEIE & shebsbebokeshobesbobebobenk:
ComFleted! BIETE shebeoketerka

Ak

W Rl T

Press the [HOME] key to exit the MENU mode.
The display changes to show the Home screen of the next file to the deleted file.

<Note>: The deleted audio file still exists on the memory card as a "hidden file". You
can restore a hidden file as the same file as before. See "Restoring a deleted audio file"
for details. When a card is optimized, hidden files are completely deleted. See "Opti-
mizing a memory card" on page 75 for details about optimizing a card.

When a USB keyboard is connected to the FR-2, you can carry out the following operation.

44 key Acts the same as the [MENU] dial on the FR-2 panel.
< key Returns to the previous screen layer.
Enter key Acts the same as the [ENTER] key on the FR-2 panel.
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Audio file protection on/off (Protect)

The following description is assumed that the FR-2 is now in the MENU mode by

pressing the [ENTER] key while the recorder is stopped.

1)

2)

3)

4)

5)

Use the [MENU] dial to select "File" and press the [ENTER] key.

The display now shows the audio file list in which all recorded audio files on the current
card are shown. If more than five audio files are stored, the list screen has more than one

page.

MEHUCL <10k

44Back

e [
8 File b |

Disk k

Setur 3

USE Mode B

FMEHUBFileCEl-H1 2k

I R [
FIEZ § seokkekokokokok [
[ HE B I
PR B shebeshokesbesheobetobhehenk [
FIRS sk [

Use the [MENU] dial to select a desired audio file and press the [ENTER] key.

The display now shows the File menu. In the screen example above, file "003" is selected.

MEMUBFilecll-B10E

44Back

FAEI] & shskesbobokebokekok
BRI 8 sheokekesbsboshohok
I‘:v"‘:-l C £ 3
FARIE & sheobsbebokeskobebobebobok

A

4
4
]
3
| 2

MEHUBFilekFileBBE(1-10]

T
Select
Eenams
[Oelete
Protect POOfTF

i

Use the [MENU] dial to select "Protect" and press the [ENTER] key.
The current protect setting (by default, "Off") starts flashing.

MEHURFilekFileBR3C1-12 MEHUEFilekFileRB3 ik
44Back 44Back
Select Select
Fernams ke — Fenams k
Lelete i felete 2

& Protect :

Use the [MENU)] dial to select the desired option ("ON" or "OFF") and press the
[ENTER] key.
The selection is fixed and the display returns to the File menu.

MEHUEFilekFileRBIka MEHURFilekFileBR3C1l- 12
44Back 44Back
Select ge lect .
Renams I > SIS
Delete 2 Delate P
Protect : FProtect :

Press the [HOME] key to exit the MENU mode.

On the Home screen of a protected file, "l" is shown at the end of the file name,
indicating that the file is protected.

<Note>: You cannot make any editing operation, as well as delete a protected file.

When a USB keyboard is connected to the FR-2, you can carry out the following operation.

AV key Acts the same as the [MENU] dial on the FR-2 panel.
< key Returns to the previous screen layer.
Enter key Acts the same as the [ENTER] key on the FR-2 panel.
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Restoring an audio file (Restore)

The following description is assumed that the FR-2 is now in the MENU mode by
pressing the [ENTER] key while the recorder is stopped.

<Note>: If you optimize a card which has any hidden files, they are completely deleted and
cannot be restored anymore.

1) Use the [MENU)] dial to select "File" and press the [ENTER] key.
The display now shows the audio file list in which all recorded audio files on the current
card are shown. In the screen example below, file 003 is a hidden file.

MEMUCL-13k MEMUEFileCfl 213k |
44Back
Cue F FIE L 8 skokokokshokohohok 3
O File b I g ¥
Oisk I I ICHE NN E S e
Setur ¥ PRI B sheokespohoksohok bk I
USE Mode BIRSE dobeokokohog I

2) Use the [MENU] dial to select a hidden file you wish to restore and press the [ENTER]

key.
The display now shows the screen as below right.
FEHUKFL 1Bl E1 0k MEHUBFilekFileRB3Cl-12
44Back T

R 1 skekokskobokoteokok
FIFIE 8 sheokokeokobeokotook

Restore F

FRZE [ ] skkkek
EIES: *

W ™ T

3) Use the [MENU] dial to select "Restore" and press the [ENTER] key.
The FR-2 starts the operation for restoring the file. When completed, "Completed!" is
shown on the screen and the display returns to show the audio file list (in the screen
example below, you can see file 003 is restored).

MEMURFilebFileRB3ZC1-17) MEHUEFilekFileBRZFReST MEHUEFiletBl A1)k
44Back iRestore FileR@B3: 44Back

M REestore [ (2 ) HE TR

| FREE3: e s

£

™ bl

5 sheokeokekekeokokokokokokok
=
-t

ComFleted! S8 seckskoksh

4) Press the [HOME] key to exit the MENU mode.

When a USB keyboard is connected to the FR-2, you can carry out the following operation.

A key Acts the same as the [MENU] dial on the FR-2 panel.
< key Returns to the previous screen layer.
Enter key Acts the same as the [ENTER] key on the FR-2 panel.
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Disk menu

The Disk menu offers the following five menu items.

* Select: Selecting the current memory card

* Optimize: Optimizing a memory card

* Format: Formatting a memory card

*Volume Label: Editing a volume label of a memory card
* Disk Info.: Viewing information of a memory card

<Note>: To carry out operations of Disk menu items, at least one memory card must be set to the
current audio file.

Selecting the current drive (Select)

This menu item selects the current drive.

When a memory card is inserted to the associated slot and the power is supplied to the
drive, the FR-2 automatically selects the drive as the current drive.

However, for example, if both CFC and ATA CF cards are inserted to the respective slots
when turning on the FR-2, you have to select the current drive by the following procedure.
The following description is assumed that the FR-2 is now in the MENU mode by pressing
the [ENTER] key while the recorder is stopped.

1) Use the [MENU] dial to select "Disk" and press the [ENTER] key.
The display now shows the Disk menu.

MEHUC1<12k MEHUEFDiskC1-10k
44Back
Cue k Select i CFC
File I — Ortimize

B Format I
SetuF 3 Uolume Labelk
USE Mode B Disk Info. ¥

2) Use the [MENU] dial to select "Select" and press the [ENTER] key.
The current drive name ("CFC" or "PCMCIA") which is automatically detected starts
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flashing.  GepyEicki 138 MEHUFDiskFSelect
44Back 44Back
s - Select H CFC |
OFrtimize [ 3 —_— OFrtimize [ 3
Format 3 Format 3
Uolume Labellk Uolume Labelk
Disk Info. Disk Info.

3) Use the [MENU] dial to select the desired drive (or "Off") and press the [ENTER] key.
When both CFC and PCMCIA cards are already inserted to the respective slots, you can

select from among the following options.

Pressing the [ENTER] key fixes selection and the display returns to show the Disk menu.

Off Both the PCMCIA and CFC drives are disabled (no memory card is selected).
CFC The PCMCIA drive is selected. The CFC drive is disabled (released).
PCMCIA | The CFC drive is selected. The PCMCIA drive is disabled (released).
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4) Press the [HOME] key to exit the MENU mode.

When a USB keyboard is connected to the FR-2, you can carry out the following operation.

+/ 4 keys

Acts the same as the [MENU] dial on the FR-2 panel.

- key

Returns to the previous screen layer.

Enter key

Acts the same as the [ENTER] key on the FR-2 panel.

Optimizing a memory card (Optimize)

You can optimize a memory card.
By optimizing a recorded memory card, any hidden audio files are completely
deleted, increasing free block space (free space) on the memory card.

The following description is assumed that the FR-2 is now in the MENU mode by
pressing the [ENTER] key while the recorder is stopped.

<Note>: If you optimize a memory card which has any hidden files, you cannot restore the
hidden files any more.

1) Use the [MENU] dial to select "Disk" and press the [ENTER] key.
The display now shows the Disk menu.

MEHUCL<1 2k

14Back
Cue
File

" SetuF
USE Mode

T e

-

—_—

MEMUBDiskcl<12k
¥

: CFC

Select

OFtimize I
Format I
Uolume Labelk
Oisk Info. B

2) Use the [MENU] dial to select "Optimize" and press the [ENTER] key.

The display shows the following caution message, in which "Are you sure?" flashes.

MEMUED sk 110k

44Back
Select i CFC
d OFtimize B |
Format 3
Lol ume Labelt

Oisk Info.

3) Press the [ENTER] key.
The FR-2 starts optimizing the card and "Please Wait!" is shown on the display. When

completed, the display shows "Completed!" and then returns to the Home screen.

MEMUMDisk BOFtimize

——=0PTIMIZIMG! ——-

Flease Wait!

MEHUMDisk FOFtimize

—=—=CAUT IOH=———
If wou Fush EMTER
kewg will be unable
to restore delete
filel

MEHUEDiskFOFLimize

-—=0PTIMIZIMG!——-

Comrleted!

When a USB keyboard is connected to the FR-2, you can carry out the following operation.

t1{ keys

Acts the same as the [MENU] dial on the FR-2 panel.

< key

Returns to the previous screen layer.

Enter key

Acts the same as the [ENTER] key on the FR-2 panel.
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Formatting a memory card (Format)

The FR-2 can format the current memory card with the FAT32 (File Allocation
Table 32) file system. The following description is assumed that the FR-2 is now in
the MENU mode by pressing the [ENTER] key while the recorder is stopped.

1) Use the [MENU] dial to select "Disk" and press the [ENTER] key.
The display now shows the Disk menu.
MEHUC1-13k MEHUEDisk 110k

44Back
Cre

: » Select : CFC
File I — OFtimize
[
4

[

B Format I
SetuF Uolume Labelk
USE Mode Disk Info. ¥

2) Use the [MENU] dial to select "Format" and press the [ENTER] key.
The display shows the following caution message, in which "Are you sure?" flashes.

MEHUERDiskCl-12F MEHUFDiskFFormat
44Back ——=CAUTION———
Select : CFC I¥ EHTER rushed.
Ortimize I* — | formatting will

d Format B start and ALl data
Volume Labelpk will be DELETED!
Disk Info. F

3) Press the [ENTER] key.
The FR-2 starts formatting the card and "Please Wait!" is shown on the display.
When completed, the display shows "Completed!" and then returns to the Home screen.

MEHUEDisk FFormat MEHUEFDisk FFormat
——=FORMATTIHG! ——— ——=FORMATTIMNG ! ———
—
Flease bWait! Comrleted!

<Note>: The default volume label of a memory card, which is automatically given
when the card is formatted, is as below.

PCMCIA: "PCM000"
CFC: "CFC000"

When a USB keyboard is connected to the FR-2, you can carry out the following operation.

+ 1y keys Acts the same as the [MENU] dial on the FR-2 panel.
< key Returns to the previous screen layer.
Enter key Acts the same as the [ENTER] key on the FR-2 panel.
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Editing a volume label of a memory card (Volume Label)

When a memory card is formatted, the default volume label is automatically given.
You can edit this volume label to the desired one.

The following description is assumed that the FR-2 is now in the MENU mode by
pressing the [ENTER] key while the recorder is stopped.

1) Use the [MENU] dial to select "Disk" and press the [ENTER] key.
The display now shows the Disk menu.

MEHUC 112k MEHUEDiskC1l-10k
44Back T
Cue 4 Select ¢ CFC
File r — OFtimize [

E Format I
SetuF 3 Uolume Labelk
USE Modes B Disk Info. ¥

2) Use the [MENU] dial to select "Volume Label" and press the [ENTER] key.
The display now shows the screen as below, on which you can edit the volume label of the
currently selected memory card. In the screen example below, the default volume label is

"PCMO0O0".

MEMUEDiskC1l- 12k MEHU DL sk o lumselbl
44Back [ECHEEE i
Select : CFC _HBCOEFGHIJEL HOEGR
OFtimize I | STUUWKYZB1Z23406T72300
Format 3 —abcdefahidk lmnoFar

: shuaz LES—a #
Oisk Info. F [+1L+ 1L INSILDEL JLOK T

The cursor in [ ] is called "volume label cursor", while the cursor in the character options
is called "character selection cursor".
You can move the character selection cursor by using the [MENU] dial.

3) Enter the desired volume label.
See the table below for details about how to enter a volume label. Up to 11 characters can

be entered.

To edit a character high-
lighted (on the cursor po-
sition)

Use the [MENU] dial to select a desired